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About This Manual

This is the latest release of instructions relating to the 3D Graphics Tool (DTL-S220A) as of Run-Time
Library 3.0. The purpose of this manual is to describe the functions and operating procedures of the 3D
Graphics Tool for the PlayStation®.

Changes Since Last Release

2D Utility Programs and 3D Utility Programs are now part of the PlayStation Data Conversion Utilities
manual. RSD, TMD, PMD and TIM file formats are now part of the PlayStation File Formats manual.

Manual Structure

Section Description

Ch. 1: Overview Presents an overview of the 3D Graphics Tools
tutorial.

Ch. 2: Creating 3D Model Data Describes modeling of some simple shapes
using the 3D Graphics Tools, with the purpose of
demonstrating the entire flow of creating 3D
models.

Ch. 3: Creating Texture Data Describes how to create texture data using the
TIM utility.

Ch. 4: Editing Material Data Describes how to edit material data using the
Material Editor.

Ch. 5: Displaying Data on PlayStation Describes the procedure for displaying 3D model
data on the PlayStation.

Ch.6: Using the Animation Tool Describes the following fundamental operations
of the Animation Tool (Ver.1.x): layout of a model;
operation of the camera; import of a DXF file;
creation of a hierarchical structure; creation of an
animation.

Ch. 7: Using MIMe Animation Describes MIMe animation, which is a technique
unique to PlayStation.

Ch. 8: Material Editor (MEDITOR.EXE) Describes all the functions supported by the
Material Editor.

Ch. 9: Animation Tool (ANIMATIO.EXE) Describes the files handled by the Animation
Tool (Ver.1.X), and explains methods of
operating dialog boxes.

Ch. 10: Miscellaneous Describes miscellaneous procedures.
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Developer Reference Series

This manual is part of the Developer Reference Series, a series of technical reference volumes covering all
aspects of PlayStation development. The complete series is listed below:

Manual Description

PlayStation Hardware Describes the PlayStation hardware architecture
and overviews its subsystems.

PlayStation Operating System Describes the PlayStation operating system and
related programming fundamentals.

Run-Time Library Overview Describes the structure and purpose of the
run-time libraries provided for PlayStation
software development.

Run-Time Library Reference Defines all available PlayStation run-time library
functions, macros and structures.

Inline Programming Reference Describes in-line programming using DMPSX,
GTE inline macro and GTE register information.

SDevTC Development Environment Describes the SDevTC (formerly "Psy-Q")
Development Environment for PlayStation
software development.

3D Graphics Tools Describes how to use the PlayStation 3D
Graphics Tools, including the animation and
material editors.

Sprite Editor Describes the Sprite Editor tool for creating
sprite data and background picture
components.

Sound Artist Tool Provides installation and operation instructions
for the DTL-H800 Sound Artist Board and
explains how to use the Sound Artist Tool
software.

File Formats Describes all native PlayStation data formats.
Data Conversion Utilities Describes all available PlayStation data

conversion utilities, including both stand-alone
and plug-in programs.

CD Emulator Provides installation and operation instructions
for the CD Emulator subsystem and related
software.

CD-ROM Generator Describes how to use the CD-ROM Generator
software to write CD-R discs.

Performance Analyzer User Guide Provides general instructions for using the
Performance Analyzer software.

Performance Analyzer Technical Reference Describes how to measure software
performance and interpret the results using the
Performance Analyzer.

DTL-H2000 Installation and Operation Provides installation and operation instructions
for the DTL-H2000 Development System.

DTL-H2500/2700 Installation and Operation Provides installation and operation instructions
for the DTL-H2500/H2700 Development
Systems.
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Typographic Conventions

Certain Typographic Conventions are used through out this manual to clarify the meaning of the text. The
following conventions apply to all narrative text except for structure and function descriptions:

Convention Meaning

courier Indicates literal program code.

Bold Indicates a document, chapter or section title.

The following conventions apply within structure and function descriptions only:

Convention Meaning

Medium Bold Denotes structure or function types and names.

Italic Denotes function arguments and structure members.

Developer Support

Sony Computer Entertainment America (SCEA)Sony Computer Entertainment America (SCEA)Sony Computer Entertainment America (SCEA)Sony Computer Entertainment America (SCEA)

SCEA developer support is available to licensees in North America only. You may obtain developer support
or additional copies of this documentation by contacting the following addresses:

Order Information Developer Support

In North AmericaIn North AmericaIn North AmericaIn North America In NorthIn NorthIn NorthIn North America America America America
Attn: Developer Tools Coordinator E-mail: DevTech_Support@playstation.sony.com
Sony Computer Entertainment America Web: http://www.scea.sony.com/dev
919 East Hillsdale Blvd., 2nd floor Developer Support Hotline: (650) 655-8181
Foster City, CA 94404 (Call Monday through Friday, 8 a.m. to 5 p.m.,
Tel: (650) 655-8000 PST/PDT)

Sony Computer Entertainment Europe (SCEE)Sony Computer Entertainment Europe (SCEE)Sony Computer Entertainment Europe (SCEE)Sony Computer Entertainment Europe (SCEE)

SCEE developer support is available to licensees in Europe only. You may obtain developer support or
additional copies of this documentation by contacting the following addresses:

Order Information Developer Support

In EuropeIn EuropeIn EuropeIn Europe In EuropeIn EuropeIn EuropeIn Europe
Attn: Production Coordinator E-mail: dev_support@playstation.co.uk
Sony Computer Entertainment Europe Web: https://www-s.playstation.co.uk
Waverley House Developer Support Hotline:
7-12 Noel Street +44 (0) 171 447 1680
London W1V 4HH (Call Monday through Friday, 9 a.m. to 6 p.m.,
Tel: +44 (0) 171 447 1600 GMT or BST/BDT)

http://www.scea.sony.com/dev
https://www-s.playstation.co.uk
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Overview
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About this Tutorial

The tutorial explains how to use the 3D Graphics Tools, giving many examples and exercises. Use each
tool, referring to the tutorial.

Proceed with the tutorial in the following order:

• Chapter 2: Creating 3D Model Data
• Chapter 3: Creating Texture Data
• Chapter 4: Editing Material Data
• Chapter 5: Displaying Data on the PlayStation
• Chapter 6: Using the Animation Tool
• Chapter 7: Using the MIMe Animation Tool

This is the order which you follow in creation of 3D graphics data.

If you read through the tutorial in this order, you will understand the outline of how to create 3D graphics
data. However, each chapter is independent, so you can refer to them at any time.
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Chapter 2:
Creating 3D Model Data
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Three 3D Model Formats

Let us see file formats related to 3D models.

The 3D Graphics Tools uses three different formats according to jobs involved in various processes of 3D
model creation.

Figure 2-1: 3D Model Formats

DXF Standard format

Used to create and edit model using a commercially available 3D modeler

RSD Artist’s format

Used for editing with 3D Graphic Tool

TMD Programmer’s format

Used for game programs

To create characters and buildings used for a 3D game, you perform modeling with a commercially available
3D modeler, convert format using the 3D Graphics Tools, add material data, and finally create a file that can
be utilized by a program.

DXF Format

To create 3D models, such as game characters, you use a graphic tool called the 3D Modeler. The
standard format, called DXF, exists in 3D models. Most of the commercially available 3D modelers support
this format. Thanks to DXF, data can be exchanged with different 3D modelers. The 3D Graphics Tools is
designed to use DXF so that you may select any desired modeler from among many 3D modelers. For
details of DXF, see the AutoCAD Reference Manual available from AutoDesk Corporation.

NOTES: trueSpace for PlayStation directly reads RSD format without using DXF.

RSD Format

RSD format is mostly used for texture mapping. This format is also used to create an animation. RSD format
consists of the following files:

• File-related data (*.RSD)
• Polygon data (*.PLY)
• Material data (*.MAT)
• Group data (*.GRP)

A model is expressed using these four files. A collection of these files is called RSD data, or simply RSD.
They can be edited easily because they are all ASCII text files. For details of the RSD format, refer to the
PlayStation File Formats manual.
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TMD Format

The TMD format is efficient for PlayStation while the RSD format is easy to use for human beings. The TMD
is the binary file and thus can be given directly to the library function which is available with Programmer
tool. It is also the format that is finally printed on a CD-ROM. For details of the TMD format, refer to the
PlayStation File Formats manual.

Creating and Converting a Simple 3D Model

Saving a 3D Model

First, let us create a simple shape, and convert DXF into RSD. Create a cube using the modeler you have. It
may not be a complete cube. Save it as DXF. Saving of DXF differs from one modeler to another. In a
certain modeler, the type of the output file may be designated as DXF in the dialog box including a Save
Under A Different Name command. In another modeler, the data may be saved using the Export command.
For details, see the manual for your modeler.

Figure 2-2: Save DXF Command

Let us see the directory structure for sample data used in this tutorial. For many samples, sub-directories
RSD and TIM are put as a pair under a common parent directory.

Figure 2-3: Example of Sample Data Sub-directories

\ PSXGRAPH
TUTORIAL

...
CUBES

RSD
TMD

The name of the parent directory indicates the tile of exercise. The 3D model is saved in the RSD directory,
and texture data pasted to the 3D model is saved in the TIM directory. In the following example, the
exercise is performed under the directory CUBES. (In this chapter, however, the TIM directory is empty
because no texture is used.)

Now, save the cubic model you created. Save DXF under the directory CUBES\RSD because it is model
data. Name the file as CUBE.DXF. There is a CUBE0.DXT file under CUBES\RSD. If you do not have a 3D
modeler, copy it under the name CUBE.DXF.
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Converting a 3D Model

Now, let us perform conversion. For conversion, you use DXF2RSD.EXE. Make sure that the MS-DOS
prompt is on the screen. Move the current directory to \PSXGRAPH\TUTORIAL\CUBES\RSD, and enter
the command described below. (The command may be lowercase letters. In the tutorial, filenames and
command names are written in uppercase letters.)

> DXF2RSD -auto CUBE.DXF

Then, four files are created under the directory: CUBE.RSD, CUBE.PLY, CUBE.MAT, and CUBE.GRP.

> DIR /W CUBE.*

CUBE.DXF CUBE.RSD CUBE.PLY CUBE.MAT CUBE.GRP

Checking the 3D Model

Let us load the created RSD data into Material Data, and display it. If Artist Board is not yet set, and if
Material Editor is not yet installed, perform setting and installation first.

Using File Manager in Windows, start MEDITOR.EXE. Select Open on the File menu, select CUBE.RSD in
the CUBES\RSD directory in the file dialog, and press the OK button.

Figure 2-4: Loading CUBE.RSD into Material Editor

You will see a white square floating at the center of the video monitor connected to Artist Board. If you hold
down the A, W, D, X, S, or C key, it rotates in the three-dimensional direction. You will clearly see that it is a
cube to which light is directed. You can zoom in and out it using the Shift+S  and Shift+C  key
combinations. Use this function as required.

When you have confirmed the cube, select End on the File menu to quit the Material Editor.

In this chapter, "Check of a 3D model" or "display of a 3D model" means to open a file using Material Editor,
rotate the cube to observe the shape, and quit from Material Editor (if necessary). In this chapter, Material
Editor is operated only once for the above purpose. Other operations of Material Editor are described in
Chapter 4, Editing Material Data (Tutorial) in detail.

In the above operation, an error is displayed on the screen and DXF2RSD.EXE may be terminated or the
video monitor may fail to display a cube normally. The cause may be an illegal DXF file, or lack of necessary
data for conversion by DXF2RSD.EXE. In most cases, such a problem can be solved by proper operation
of the modeler, or designation of options in DXF2RSD.EXE. If a cube is not displayed properly even though
RSD data has been created, read Options in DXF2RSD.EXE (the PlayStation Data Conversion Utilities
manual) and try again. If you cannot create RSD, see DXF2RSD.EXE in the PlayStation Data Conversion
Utilities manual.
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Options in DXF2RSD.EXE

This section describes some useful and important options. In the following description, [ ] indicates a button
or field name applicable to DXF2RSDW.EXE, which is the Windows version of DXF2RSD.

Automatic Scaling [Automatic Size Adjustment]
-auto

We used only this option in the exercise for a cube in the previous section. This option automatically
expands and shrinks DXF model data to a size suitable for model data for PlayStation (so that the cube may
be put within a cube whose dimension of a side is 1000). At the same time, the model is moved parallel to
the center of the screen (the zero point of the coordinate system) wherever it may be originally located in the
3D space. Generally, the 3D modeler has its own unit of length. So, a model may be too small or too large
to see even if data is simply converted. This function is helpful when you want to check how a model is
seen on PlayStation.

If you already know the dimensions and position of the model, you can directly specify the scale factor and
amount of parallel translation using the following options:

Scale Factor [Magnification Factor]
-sc factor

Expands or shrinks a model. Specify a scale factor (decimal fraction) in the argument.

Parallel Translation [Model Position]
-t dx dy dz

Moves a model. Specify the amount of movement in the direction of each axis in the argument.

Normal Inversion [Polygon Attribute, Normal Inversion]
-back

On some modelers, a cube that was prepared with Material Editor may look semi-transparent when it is
displayed, or it may look strange because it is out of perspective when it is rotated. You see both front and
back of each polygon because they are not properly defined.

Figure 2-5: Cube with Inverted Normal Vectors

DXF does not allow direct description of "front and back of a polygon". The front is determined according to
the order of description of vertices of a polygon. Depending DXF, this order may be reversed. In such a
case, the front and back can be exchanged by specifying this option. The vector that expresses the
direction of the front of a polygon is called a normal vector.
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BACKCUBE.DXF is a cube consisting of polygons whose front and back are inverted. Observe how the
cube looks when the -back  option is used and not used.

Coordinate Conversion [Coordinate System]
-Y-Z  -Y+Z  +Y-Z  +Y+Z  -Z-Y  -Z+Y  +Z-Y  +Z+Y

In 3D modeler, you adjust the shape of the entire 3D model while changing the viewpoint to front, rear,
right, left, up, and down. If you display a model on PlayStation, the front of the model may be put to the
side, or to any other direction.

This is because the coordinate axes are not properly determined by the 3D modeler. Using this option, you
can specify the method of conversion of the coordinate system. You specify the coordinate axes at the front
and on the top as seen from the front of the coordinate system of the modeler. For instance, -Y+Z means
that the front is the negative of the Y-axis, and the top is the positive of the Z-axis. Default is -Y+Z.
DXF2RSD.EXE converts them to the coordinate system (-Z-Y: The front is the negative of the Z-axis, and
the top is the negative of the Y-axis.) for PlayStation. (Figure 2-6)

Figure 2-6: Conversion from 3D Modeler Coordinate System to Play Station Coordinate System

The front and back of a polygon are inverted each time you exchange Y-Z axis and + and - once using this
option. If you specify correctly, you do not have to specify the -back  option.

CAUTION: The coordinate system for DXF is described above. It does not always match with the
coordinate system on the screen depending on the 3D modeler. Therefore, prepare a 3D
model, such as a character, whose top, bottom, right, and left can be easily seen, and find a
suitable option so that the front may be displayed when it is loaded from Material Editor.

You do not have to be nervous about coordinate conversion. Even if there is an error in
coordinate conversion, you can correct it using the program because the viewpoint can be
freely set with the program. However, the front and back must be correctly set.

Quadrangular Polygon [Polygon Shape, Quadrangular]
-quad

Generates a quadrangular polygon. If this option is not specified, the model is divided into triangular
polygons. You can reduce the number of polygons using this option.

Smooth Shading [Smooth Shading]
-s-g or -s

Used to create model data for smooth shading. Normal vectors are assigned to all the vertices, and their
directions are gradually changed to realize smooth surfaces. If this option is not specified, flat shading
ensues, and a normal vector is formed on each polygon, and not on each vertex.
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Figure 2-7: Flat Shading and Smooth Shading (Arrows indicate normal vectors related to the quadrangular polygons)

Smooth shading for a cube is difficult to understand. Make a try using a curved-surface model, such as a
ball. (Sample data in SPHERE.DXF is sphere data.)

Data Display [Data...]
-v
-info

Using these options, you can see the position and size of a DXF model. These options display the types of
polygons (triangle, quadrangle, polyline) and their numbers. They are helpful when estimating the
approximate quantities of data. The size of a created model is approximately determined depending of the
modeler. It will be advisable to know approximate values by executing these options beforehand. (Thus, you
can see the scale factor by which a model should be expanded or shrunk.) The -v  option performs
conversion, and the -info  option does not perform conversion.

If you perform conversion using sample data in CUBE0.DXF, and specifying the -V  option, the screen
display shown in Figure 2-8 appears.

Figure 2-8: Sample Output for -v Option

> DXF2RSD -v CUBE0.DXF
==================================================
 Input DXF file   : CUBE0.DXF
 [DXF] SIZE       :  204 lines
       VERTEX     :   24
       POLYGON    :   12 (estimate)
                    4-poly   :   6
       RANGE  x   : -250.000 ... +250.000
              y   : -250.000 ... +250.000
              z   : -250.000 ... +250.000
       MATERIAL   :   0

 [RSD] VERTEX     :   8
       POLYGON    :   12
                    triangles   :   12
       MATERIAL   :    0
       NORMAL     :   12

 Output files     : CUBE0.[rsd, ply, mat, grp]

The above sample output indicates that the number of lines (size) of CUBE0.DXF is 204, the number of
vertices is 24, and the number of polygons is equivalent to 12 (converted into the number of rectangles). In
reality, the model consists of six quadrangles (4-poly). RSD in the output indicates eight vertices, and twelve
polygons, and that they are all triangles.

For details of the output, see DXF2RSD.EXE in the PlayStation Data Conversion Utilities manual. For options
in DXF2RSD.EXE, also refer to the above description.
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Most of the functions of DXF2RSD.EXE can be also used with Windows version DXF2RSDW.EXE. For
details, see DXF2RSDW.EXE in the PlayStation Data Conversion Utilities manual or on-line help. Even if free
memory space is insufficient in MS-DOS, conversion is sometimes possible if you use DXF2RSDW.EXE.

Creating a Helicopter and Tips for Modeling

This is an exercise using a 3D model more worthy of the name game character. This section describes
important points you should understand when creating a 3D model for PlayStation. Because PlayStation
performs all the calculations for drawing real-time, you need special techniques different from a 3D still
picture, the rendering of which is allowed to take several tens of hours.

Prepare a helicopter as shown in the figure below, and convert it into RSD. In the subsequent chapters,
RSD data will be used to apply colors or patterns, and make the window of the cockpit semi-transparent.

Figure 2-9: View of Finished Helicopter

This helicopter consists of two objects: body and rotor. They can move independently, and hierarchical
relations between them can be defined. For these purposes, however, each object must be created as
different RSD data. (In other words, the parts that move in concert with each other should be defined as
one object and coordinated into the same RSD even if they are apart from each other.)

Details will be discussed in Chapter 6, Using the Animation Tool (Tutorial). Here, you should understand that
an object is a part moving independently, and that each object corresponds to its own RSD (and DXF,
consequently).

Prepare the body, performing the exercise under the HELIMAKE directory. Key points in modeling are
described below. Prepare the body according to the following description.

Principle of Common Vertices

A side, excepting its vertex, of a polygon should not contact any other vertices. In such a case, the polygon
must be divided so that such vertex may be a vertex of all the adjacent polygons. This is called the principle
of a common vertex.
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Figure 2-10: Non-Common and Common Vertices

If a vertex of another polygon is located on a certain polygon as seen in the right-hand view in Figure 2-10,
a gap will be created among polygons as shown in Figure 2-11. No problem will arise in case of a 3D still
picture. However, calculation of coordinates of a point located on the straight line connecting the two
vertices involves errors because coordinate values for a 3D model handled by PlayStation are calculated
real-time. As a result, a gap is created among the sides adjacent to each other. On the contrary, if a side of
one polygon is in contact with, and coincides with, a side of another polygon (that is, both of these sides
have the two same vertices at both ends) as shown in the right-hand view in Figure 2-10, no gap is created
because no error is caused for any sides that are in contact.

Figure 2-11: Gap Caused by Non-Common Vertices

Also, avoid coupling two 3D models prepared independently from each other by mating the surface of one
polygon to that of another as shown in the figure below. No problem will arise if the vertex coordinate values
are just the same. Otherwise, a gap will be created. The two coupled surfaces are useless polygons that are
never seen.

Figure 2-12: Improper Sample (Pasting of Polygons)

Using the modeler, you should extrude an existing surface or side to create a new surface instead of
inserting new vertices to a middle point of a side, or to any other position (even if you can do so). This
function is one of the fundamental functions of the 3D modeler, which is called Extrusion.
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Figure 2-13: Extrusion of Surface

Otherwise, a fundamental shape, such as a rectangular parallelepiped, may be divided into small polygons,
and then the shape may be modified by moving the vertices.

In this tutorial, the extrusion function (sweep and slice) of the 3D modeler called trueSpace for PlayStation is
repeatedly used to prepare the helicopter.

HELI1.DXF  through HELI5.DXF  in the HELIMAKE\RSD directory include such data.

Number of Polygons

The surfaces of the helicopter included in sample data are relatively rough. The 3D modeler can be used to
change its shape into one having many curves. To express a curve using polygons, many small polygons
are needed. If too many polygons are used, a great burden will be imposed on drawing, and missing frames
are likely to result. The person who prepares a model must know how many polygons can be used.

When preparing a scene in a game, determine the number of polygons used for each object considering
the balance of the entire screen. The main character will need many polygons, and buildings in the
background should consist of fewer polygons. The performance (maximum 360,000 polygons without
texture per second) of PlayStation allows the use of about 12,000 polygons for a display of 30 frames per
second, and about 6,000 polygons for a display of 60 frames per second. Fewer polygons may be used if
textures are employed, or if smooth shading is performed. The number of polygons is also greatly affected
by the size of polygons on the screen, and the program composition. It is advisable to prepare a model so
that it consists of 2,000 to 3,000 polygons per frame. Based on this, find the number of polygons used with
each object. A game that has a very beautiful screen generally uses such a number of polygons. To get
beautiful screen display, it is more effective to minutely prepare textures than increase the number of
polygons. Rough polygons can look smooth if smooth shading is performed. (For instance, display
HELI5.DXF  using DXF2RSD.EXE with the -g  option. You will see a fairly round shaped object.)

Figure 2-14: Helicopter Subjected to Smooth Shading
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Front and Back of Polygons

The canopy of the cockpit will be made semi-transparent in Chapter 4. The procedure is described in that
chapter. Display semi-transparent sample data HELI5T.RSD  using the Material Editor.

If you turn the helicopter, you will see that the canopy is semi-transparent. If you look at it from the front, the
tail of the helicopter is seen through the wall at the rear of the cockpit. You are seeing the "back" of the wall
behind. When you look from the side, you cannot see the inner wall at the side on the end opposite to the
canopy at the front. In the 3D world of PlayStation, the back of a polygon does not reflect light at all. So,
you see nothing there. As a result, you will see a hole in the body.

To prevent this, you must insert a front-faced polygon into the inner wall of the cockpit. As an example, let
us create the cockpit.

You should learn by heart the equation "Front of polygon = Direction of normals of polygon = Seen". If there
is a polygon that is observed in the wire frame but, is not displayed, you should check to see if there is a
reversed polygon.

Creating the Cockpit

Attach a cockpit to the body. Unless the wire frame is used, you cannot see polygons at the inner part
(inside) of the 3D model, such as the cockpit. However, you can see it through the canopy when the
canopy is made semi-transparent using Material Editor in Chapter 4.

Figure 2-15

It will be easier to prepare the cockpit separately from the body, and paste it later. You should use care
when preparing the shape of the cockpit. The left-hand view above shows the cockpit consisting of a
folded sheet, which has no volume. Some modelers (solid modelers) do not allow you to prepare such a
shape. In that case, the shape of one side of a rectangular parallelepiped as shown in the right-hand view
may be changed. HELI6.DXF  is the model that uses the cockpit shown on the right. In HELI6T.RSD , the
canopy is made semi-transparent.

The watt at the side of the cockpit can also be prepared in the similar manner. You can easily create it using
the Copy button and Front-Back Reverse button in the Material Editor. For details, see Chapter 8, Material
Editor (Reference).

You cannot see the cockpit until you make the canopy semi-transparent in Chapter 4. HELI9.DXF
includes a model to which the cockpit is added. In HELI7.RSD , the canopy is made semi-transparent.

Z Sort Problem

Using the Material Editor, check HELI6T.RSD , which is described in the previous section. If you rotate the
object, you will see polygons on the sides and bottom of the body flickering. This is the disturbance of
drawing, which is called Z Sort, ascribable to the method of polygon drawing that PlayStation employs. Z
sort is a method used to determine the order of drawing of polygons in the order of depth. The position in
the direction of the depth of the center of gravity of each polygon is calculated, and the polygon concerned
is drawn if it is judged to be located at the front of the already drawn polygons. Z Sort is suitable for real-
time drawing because it is more efficient than other sort methods.
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Disturbance of drawing due to Z sort occurs when two polygons are pierced into each other, or they are
closely located. This is because the results of calculation of the position in the direction of the depth is
affected by the viewpoint and direction so that the polygons behind overwrite the polygons at the front. This
is called a Z sort problem, which a person who creates a 3D model must bear in mind.

Figure 2-16: Z Sort Problem

Measures to solve the Z sort problem are described below. Some measures may be employed during
modeling, and others may be adopted for programming. Take suitable measures after consulting with the
person responsible for the entire program.

1. Change the way in which model data is created. Give minute consideration to the shape and layout of
polygons by putting apart two polygons from each other, etc. Avoid using thin and long polygons
because they are more likely to cause the Z sort problem. Sometimes, you can get around the Z sort
problem by using quadrangular polygons.

2. Increase the size of the polygon causing Z sort. If you simply use smaller polygons, the number of
polygons will increase. So, you should pay attention to trade-off.

3. Increase the size of the ordering table (OT) used for the program. Thus, you can improve the precision
of Z sort. You can set the size of OT using the screen display of Material Editor. However, the load will
increase as the size of OT increases.

4. Explicitly describe the order of drawing in the program. For example, when an automobile runs on a
road, no Z sort problem concerning the road and tires will arise if you always draw the road first. This
method is very effective when the order of drawing is fixed as in the above example.

HILI8.DXF  includes an improved helicopter sample. In HILI8.RSD , the canopy of the cockpit is made
semi-transparent. In this sample, the shape and size of polygons near the cockpit are changed. Observe
how they are seen on the Material Editor. If you encounter a Z sort problem in your model, and if you want
to solve it, make an effort to improve the model.

Near-Clip Problem

As the viewpoint closely approaches a polygon, it may become too large to display on the screen. This
occurs when you enlarge a polygon by continuously holding down Shift + X  on the Material Editor. This
is called near-clip. In a racing game where the viewpoint moves along the road, the portion near the front
may be cut off, spoiling the scene.

To avoid this, it is effective to use the automatic split function of the library for the program. However, this
function causes a great load during execution of the program. If the portion where near-clip occurs is
known, the polygons in that section may be divided further to alleviate the inconveniences.
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Hierarchical Structure

If you attach the rotor to the body you created, the helicopter will be completed. Save the data in DXF, and
convert it into RSD by running DXF2RSD.EXE. Because the body and rotor are separate objects, save their
data to different DXF. For safety, let us save the entire data. At this time, data may be in DXF or in any other
format. Data may be in any format as long as it can be loaded whenever necessary to do the same job
again. (It is a good practice to save data under different names during modeling. It can happen very often
that you find a defect during editing, and it is impossible to perform Undo when you notice it.)

To save objects separately, you may follow these steps:

1. With all the objects displayed on the screen, select all the objects except the one that you want to save.
2. Delete the selected objects.
3. Give a new name to the remaining object, and save it as DXF.
4. Restore all the objects by performing Undo or loading the file. Return to step 1 and save the next

object.

Separately save the body and rotor as HELI.DXF , and ROTOR.DXF.

Some 3D modelers are able to save a selected object. Check this by referring to the manual for your 3D
modeler.

When all the objects have been saved, convert them into RSD by executing DXF2RSD.EXE.

>DXF2RSD HELI ROTOR

There are sample data HELI8.DXF  and ROTOR0.DXF. Copy them if necessary.

When all the necessary RSD data has been prepared, add surface attributes to them. In Chapter 4, textures
will be pasted, and the windowpane will be installed on the canopy to make the model real.
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You can edit texture data used in PlayStation using a file format called TIM. A file in this format can be
handled by Sprite Editor (SPRITE.EXE ). TIM data can be created by converting data prepared by various
event tools available from Windows and Macintosh.

For this purpose, BMP2TIM.EXE, PICT2TIM.EXE , RGB2TIM.EXE, and TIMUTIL.EXE  are used as
converters. A plug-in module that allows the reading and writing of TIM files in Adobe PhotoShop is also
available. (See the TIMEXP.8BE and TIMFMT.8BI in the PlayStation Data Conversion Utilities manual.)

How to convert using the conversion utility, TIM Utility (TIMUTIL.EXE ), is explained below.

TIM Utility allows use of BMP, which is generally used in Windows, PICT used in Macintosh, general-
purpose format RBG, and TIM for PlayStation. It converts one format to another, and allows setting of
various parameters.

Example of Conversion into TIM

Conversion of sample data (\PSXGRAPH\TUTORIAL\TIMUTIL\TIM\A.BMP )

This section describes the procedure for fundamental format conversion using sample data.

Now, start TIM Utility (TIMUTIL.EXE ) using File Manager. Select Open... on the File menu of TIM Utility.
The next dialog box pops up.

Figure 3-1: Selecting a File before Conversion

If necessary, move the directory to \PSXGRAPH\TUTORIAL\TIMUTIL\TIM , select a.bmp , and press the
OK button. Then, the following window opens:

Figure 3-2: TIM Utility Opening A.BMP
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Let us check the contents of the A.BMP file. Press the Display... button. The following window appears:

Figure 3-3: Displaying A.BMP

This window displays the image contained in the A.BMP file. (You can close this window by pressing the
Esc key, or selecting Close on the menu at the left corner of the window.)

Now, convert this image file in BMP format into TIM format. Make sure that Writing format is TIM. (If the file
is in any other format, select TIM using the left button of the mouse.) Press the Convert... button, and the
following dialog box pops up.

Figure 3-4: Specifying a Filename after Conversion

Press the OK button, and conversion from BMP to TIM format starts. During conversion, you see the
following dialog box on the screen:

Figure 3-5: Dialog during Conversion

When "100% completed" is displayed, conversion is over.

Now, a TIM format image file \PSXGRAPH\TUTORIAL\TIMUTIL\TIM\A.TIM  has been created.

Confirming the Results of Conversion

Let us open the \PSXGRAPH\TUTORIAL\TIMUTIL\TIM\A.TIM  file. You may open
\PSXGRAPH\TUTORIAL\TIMUTIL\TIM\A.TIM  by selecting Open... on the File menu as you did to open
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A.BMP. However, let us use the drag and drop function of File Manger. Using File Manger, display the files
under the \PSXGRAPH\TUTORIAL\TIMUTIL\TIM  directory.

Figure 3-6: File Manger for Windows 95

Select a.tim  on the window using the left button of the mouse. While holding down the left mouse button,
drag it to the window for TIM Utility. When the mouse cursor is put into the window for TIM Utility, release
the button. Now, A.TIM  is opened.

Figure 3-7: TIM Utility Opening A.TIM

Check the results of the conversion. You can display the results using the Display... function as you did for
A.BMP. However, images displayed by this function may differ a little from those actually displayed by
PlayStation in tints, etc. So, let us use the TIM Display... function which can only be used when a file of TIM
format is opened. If you press this button, you can display a TIM image on the video monitor connected to
Artist Board. Press the TIM Display... button. The following dialog box pops up, and the image is displayed.

Figure 3-8: Display on Artist Board
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Using this dialog box, you can specify the image resolution of Artist Board, and display area start position
on VRAM. You can scroll the image up and down, and to right and left by changing the display start
position.

Now you understand how to convert A.BMP into A.TIM , and how to check the results. The following
section explains the other functions of TIM Utility.

Transparency Control

You can specify an attribute called "transparency control bit" for a TIM format image file for PlayStation.
Utilizing this function, you can dig a hole in a polygon, and give an effect of semi-transparent glass using
textures. By making the best use of it, you can express a complicated shape using a small number of
polygons.

Example: Broken Canopy

Using TIM Utility, open \PSXGRAPH\TUTORIAL\TIMUTIL\TIM\B.TIM . Set X in Image Zero Point to
640, and check the two check boxes for transparency control.

Figure 3-9: TIM Utility Opening B.BMP

Make sure that all the items are set as shown in the above figure. Press the Convert... button. Be sure that
the filename is B.TIM .

Now, start Material Editor (MEDITOR.EXE) using File Manager. (For details about Material Editor, see
Chapter 4.) Select Open on the File menu of Material Editor to open
\PSXGRAPH\TUTORIAL\TIMUTIL\RSD\EX1.RSD . The Texture Layout dialog box pops up.
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Figure 3-10: Texture Layout Dialog (Material Editor)

Make sure that X in Texture is set to 640, and press the OK button. The following image appears on the
video monitor connected to Artist Board:

Figure 3-11: Screen display 1 of RX1.RSD with Material Editor

You can rotate the displayed model to up and down, and to right and left using the W, X, A, and D keys on
the keyboard. You will see a red ball through semi-transparent blue, and through a tear at the center.

Such effect is obtained because you checked “Semi-transparent colors excepting black,” and "Transparent
black" in Transparency control on conversion from B.BMP to B.TIM . The texture image (B.BMP) for this
example is as follows:
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Figure 3-12: B.BMP

The tear at the center is painted in black (R, G, and B: all 0), and all the other portions are painted in light
blue. So, the rent is made transparent, and the surrounding portions are made semi-transparent when
B.BMP is converted into TIM format. If B.TIM  is generated without checking "Semi-transparent colors
excepting black,” the following screen display appears when \PSXGRAPH\TUTORIAL\TIMUTIL\RSD-
\EX1.RSD  is displayed using Material Editor:

Figure 3-13: Screen Display 2 of EX1.RSD with Material Editor

The light blue portion, which looked transparent in the example in which Transparency control was
checked, now looks opaque.

Restrictions

TIM Utility of the current version performs very rough transparency control for black and other colors. If you
want to set transparency control bits for each color on the palette concerning TIM consisting of less than 8
bits, you may use Sprite Editor (SPRITE.EXE).

Layout of Textures

Textures and palette (CLUT) areas used by PlayStation must be so laid out that they may not be overlaid on
other textures, palette, drawing/display areas. To aid such a job, TIM Utility is equipped with a function that
graphically lays out textures and palettes.
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Re-layout of Sample Data

Open A.TIM  and B.TIM  under the \PSXGRAPH\TUTORIAL\TIMUTIL\TIM  directory, which were
created above, and open the already created C.TIM .

Figure 3-14: TIM Utility Opening Three TIM Files

Now, select TIM layout... The following dialog box pops up.

Figure 3-15: TIM Layout Dialog 1

The above figure shows the areas on VRAM occupied by images and palettes in A.TIM , B.TIM , and
C.TIM . The broken lines indicate the texture page boundary, which will be discussed later in Cautions in
Texture Layout (p. 3-12). You will see some portions displayed in red (printed in the darkest gray on the
paper). They indicate that a problem will arise when textures are actually displayed by PlayStation. A.TIM  is
located on the drawing/display area. C.TIM  is overlaid on the area of B.TIM . The palette areas for A.TIM
and B.TIM  are also overlaid. They must be moved to such positions that they may not be overlaid on each
other. We must move each texture area to a position along the texture page boundary.
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Move A.TIM  first. Select the area for A.TIM  using the left button of the mouse. While holding down the
mouse button, drag it to the right. When it is moved to the right side of B.TIM , release the mouse button.

Figure 3-16: TIM Layout Dialog 2

You will see the screen display shown in the figure above. It is difficult to precisely put A.TIM  onto the
texture boundary using the mouse. There are two methods to get around the difficulty. One method is to
set numerical values in X and Y for the data area to determine the position. The other method is to utilize
the grid function. We will use the second method because it is more convenient.

First, select Texture page and XY on the Grid menu. Using the mouse, drag A.TIM  so that the left top
corner of A.TIM  may be put near the right top corner of B.TIM . Release the mouse button, and A.TIM
moves to a position along the texture page boundary. In this status, the screen display looks as follows:

Figure 3-17: TIM Layout Dialog 3

Now, A.TIM  and B.TIM  are moved to desirable positions. However, C.TIM  is overlaid on A.TIM  and
B.TIM . Looking at the screen, you will see the lower half of VRAM empty. Move C.TIM  to the left bottom
as you did to move B.TIM . At this time, move the left corner of C.TIM  near the left bottom corner of
B.TIM . The result will be as follows:
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Figure 3-18: TIM Layout Dialog 4

Now, red portions have almost disappeared. If you look closely, there is a red portion in the palette area.
Palettes in A.TIM  and B.TIM  seem to be overlaid on each other. (C.TIM  has no palette because it is a 16-
bit texture.) To relocate the palettes, you may use the same method you used to move the image area of
the texture, but there is a simpler method.

Select Palette on the Arrangement menu. This function puts all the palettes vertically as seen from the lower
end of the display area. Make sure that the palette area that was displayed in red has changed into green.

Now, the position data on the defective texture has been corrected. Press the OK button, to return to the
main window of TIM Utility.

Figure 3-19: TIM Utility Completing TIM Layout

Make sure that the values of the image zero point and palette zero point have been changed by TIM layout.
In this stage, however, the changes to the image zero point and palette zero point are not reflected in the
TIM file. To do so, you may press the Convert.. button to save each file. There is a better method. Select
Save all files... on the File menu. The following dialog box pops up.
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Figure 3-20: Dialog for Directory Selection

Make sure that the displayed directory is the same as that shown in the above figure. Press the OK button.

Data on the image zero point and palette zero point is written to A.TIM , B.TIM , and C.TIM . The following
dialog box appears, and writing of the image zero point and palette zero point is completed.

Figure 3-21: Zero Point Writing End Dialog

Cautions in Texture Layout

In VRAM of PlayStation, the position where texture data can be put is restricted by the boundaries set at
intervals of 64 words in the X direction, and at intervals of 256 lines in the Y direction. These boundaries are
called texture page boundaries, and the area demarcated by these boundaries is called a texture page.

When actually pasting textures to polygons, UV values (0 through 255), which are offset values, or the
numbers of pixels from the texture page and texture page boundaries described above, determine texture
data.

If texture data is placed just along the texture page boundary, a texture consisting of up to 256 x 256 pixels
can be displayed. If the texture data is put aside from the texture page boundary, the size of the texture will
be smaller.

In the transverse direction, data must be put within one texture page if it is a 4-bit texture. In case of an 8-
bit texture, it must be within two texture pages. A 16-bit texture must be put within four texture pages. In
the vertical direction, texture data must be arranged so that it may always be put within one texture page.
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Improper Example

Figure 3-22: Bad Examples

1. A 4-bit texture. Vertically, it is put within one texture page, but it transversely crosses the texture page
boundary.

2. A 4-bit texture. Transversely, it is put within one texture page, but it vertically crosses the texture page
boundary.

3. An 8-bit texture. It is transversely put within one texture page, but it vertically crosses three texture
pages.

4. An 8-bit texture. It is vertically put within two texture page, but it transversely crosses the texture page
boundary.

5. A 16-bit texture. It is transversely put within one texture page, but it vertically crosses four texture
pages.

6. A 16-bit texture. It is transversely put within four texture pages, but it vertically crosses the texture page
boundary.

Supplement

You cannot read compressed BMP, JPEG, compressed PICT, 32-bit PICT, and PICT, which does not
include any bit map.

You cannot write compressed BMP, JPEG, and compressed PICT format. The depth of bits in the write file
is restricted to 4, 8, 16, and 24 bits.

If conversion is performed to reduce the bit depth (for instance, from 16-bit data to 8-bit data), color data is
approximated. In this case, the precision of colors will be impaired because color maps to which R, G, and
B are evenly assigned are used for approximation instead of the method of color compression.

In addition, there are command line tools that can be entered to the DOS prompt, such as BMP2TIM.EXE
(from Windows BMP to TIM), PICT2TIM.EXE  (from Macintosh PICT to TIM), and RGB2TIM.EXE (from
general-purpose RGB format to TIM). You can utilize them when you are not using Windows, or when you
perform the same conversion repeatedly. For use of each tool, see the appropriate reference manual.
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What is Material Editor

Material Editor is a tool that edits the surface attributes (materials) of polygons, such as colors, textures
(patterns), and shading methods of 3D models.

By setting various surface attributes, you can make the model look real. Material Editor allows setting of the
following surface attributes, which can be expressed on PlayStation, to each polygon:

• Color
• Texture
• Transparency (opaqueness, or semi-transparency)
• On/off of light source calculation
• Shading method (flat or smooth)

Tutorial 1 in this chapter describes fundamental operations, and then Tutorial 2 explains advanced
functions.

Tutorial 1 (Fundamental Operations)

This tutorial introduces fundamental use of Material Editor using a sample model (body of the helicopter). If
Material Editor and Artist Board are not installed into your machine, install them.

Starting Material Editor

To Start Material Editor, execute MEDITOR.EXE under the standard directory (C:\PSXGRAPH\BIN ) for the
3D graphic tools. If the program is saved to Program Manager for Windows, you can start Material Editor
using Program Manager by double-clicking the following icon marked with Material Editor:

Figure 4-1: Icon in Material Editor

When Material Editor has been started, the opening window displaying the Material Editor version number
and copyright pops up.

Figure 4-2: Opening Window

NOTES: If the version number of your Material Editor is earlier than 1.70 (e.g. 1.68c), install the latest
version from floppy disks or the BBS. This tutorial is intended for Material Editor version 1.70 or
later. Normal operation is not guaranteed if an earlier version is used.

Material Editor uses Graphics Artist Board (DTL-H201A). Upon starting, the address written in the
Artist Board port address setting file (C:\WINDOWS\ ABOARD.INI ) is used as the port address
of Artist Board. For instance, if ABOARD.INI  specifies

addr=0x1340

Material Editor communicates with Artist Board using the port address 0x1340. Normal
communication cannot be performed unless the port address of the board is set to 0x1340 using
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DIP switches. If the DIP switches are not properly set, the following warning window will appear,
and Material Editor will be terminated.

Figure 4-3: Port Address Warning Address

In this case, correct the ABOARD.INI  file using the ABOARD.EXE tool, or change the address of
the board itself so that the values of these addresses may become the same.

For the ABOARD.EXE tool, see ABOARD.EXE in Chapter 10, Miscellaneous (Reference). For the
procedure for changing the port address of Artist Board, see the manual for Artist Board.

Click the OK button on the opening window, and the main window of Material Editor appears.

Figure 4-4: Main Window of Material Editor

Loading Model Data

1. Select Open on the File menu.
2. A file selection dialog box appears on the screen. Select the following file, and click the OK button:

C:\PSXGRAPH\TUTORIAL\MEDITOR\TUTO1\RSD\HELI.RSD

3. The Texture layout dialog box appears on the screen. Without minding what the dialog box tells you,
click the OK button.

A helicopter is displayed on the video monitor. It is a finished helicopter which you create in Tutorial 1.

Figure 4-5: Finished Helicopter
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Rotation of Helicopter; Parallel Displacement of Viewpoint

While rotating the helicopter, let us see it from various angles.

1. The following keys allow you to rotate the helicopter:
A Left
D Right
W Up
X Down
S Twisted clockwise
C Twisted counterclockwise

2. You can move the viewpoint parallel.
Shift-A Left
Shift-D Right
Shift-W Up
Shift-X Down
Shift-S Inward
Shift-C Toward front

In either case, holding down the key continues to rotate or move the model.

You can find the above key binds any time if you select the Key Bind command.

When editing materials, you have to frequently rotate a model, or move it parallel. So, you should become
familiar with model operation from the keyboard.

NOTES: The helicopter will not move unless Material Editor is selected. Before manipulating the keys, be
sure to select main window of Material Editor.

TIPS: If you shorten auto repeat start time and repeat interval for the keyboard, the object will be
rotated and moved smoothly. You can change these settings by double-clicking Control Panel in
Program Manager for Windows to start the keyboard.

Loading Helicopter Data

Let us load data to which no material is set. Following the same steps you followed earlier, call up the
following file:

C:\PSXGRAPH\TUTORIAL\MEDITOR\TUTO1\RSD\HELI00.RSD

Now, a white helicopter appears on the video monitor. It is a DXF file created with a commercially available
modeler converted into RSD using the DXF2RSD converter.

Figure 4-6: Initial Status of Helicopter

Painting the Canopy

Change the color of the canopy of the white helicopter cockpit to light blue.
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1. Click material menu, and the following material setting dialog box appears:

Figure 4-7: Material Setting Dialog

This dialog box has many radio buttons and push buttons used to set materials. Do not push any
button yet.

The top part of the dialog box shows the RSD file currently loaded, and the number of polygons
contained in the object. Below these items, you see the ID of the polygon you selected last.

2. Click the polygon selection button at the left bottom of the material setting dialog box.

The mouse cursor on the Windows screen disappears, and a white cross cursor appears on the video
monitor. (If you cannot find the cross cursor, move the mouse to see it.)

This status is called polygon selection mode. In this mode, the polygon on which the cross cursor
appears is selected if you left-click the mouse. If there are two or more polygons under the cross
cursor, the foremost one is selected. You cannot select a polygon whose back is faced up.

You can easily identify a selected polygon because it turns red, and the boundaries are displayed in
yellow.

Right-click the mouse to cancel polygon selection mode. The mouse cursor will return to the Windows
screen.

3. Moving the cross cursor and helicopter, select all the polygons within the canopy.

As shown in the figure below, you select sixteen polygons in all.



Tutorial: Editing Material Data 4-7

3D Graphics Tools

Figure 4-8: Selection of Canopy

To cancel selection of a polygon, click that polygon again while holding down the control key.

When the polygons within the canopy have been selected, right-click the mouse to quit from polygon
selection mode.

TIPS: To select all the polygons within the canopy, you have to rotate the helicopter, and move it back
and forth, and to right and left. You can do so easily if you select any desired polygon by
manipulating the cross cursor with the right hand while moving the model by operating the keys
with the left hand.

4. Click the color radio button on the material setting dialog box.

Windows standard Color Setting dialog box appears. Select a color suitable for the canopy. The color
setting dialog box is a Windows standard function. For details, see the manual for Windows.

Click the OK button on the color setting dialog box, the selected polygon is painted with the selected
color.

Figure 4-9: Canopy Painted in Light Blue
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TIPS: If you do not like the painted color, you can paint the canopy in any desired color as often as you
like by clicking the color radio button without selecting the polygon again if you have not pressed
the OK button in the color setting dialog box.

Saving the Canopy as a Group

Let us examine the group function of Material Editor. A group is a set of polygons. You can create a group
freely. You can select all the polygons that belong to a group by selecting the group. For instance, if you
save polygons to be painted in the same color as a group, you can select all these polygons at one time
whenever you want to change their color.

Save the canopy (sixteen polygons) as a group. If you have not painted them, select the Open command on
the File menu to load the following file, which contains sample data:

C:\PSXGRAPH\TUTORIAL\MEDITOR\TUTO1\RSD\HELI01.RSD

1. Click the Polygon Selection button on the material dialog box to select the sixteen polygons for the
canopy.

2. Right-click the mouse to cancel polygon selection mode, and select group menu. A group control
dialog box appears on the screen. You will find that the "new group" part at the top indicates "16" as
the number of selected polygons.

3. Click the Save button on the group control dialog box.

4. A group name dialog box appears. From the keyboard, enter "canopy" as the group name.

5. Click the OK button on the group name dialog box. The canopy group is now saved. The group name
and the number of polygons are displayed in the group list.

Figure 4-10: Group Control Dialog Box Saving Canopy Group

6. Click the line indicating "window(16)" in the group list. On the video monitor, make sure that all the
polygons for the canopy are selected at one time.

7. While holding down the control key, select window(16). On the video monitor, you will see selection of
polygons for the canopy is canceled.
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8. After selecting window(16), press the Cancel button. The window group is canceled, and deleted from
the list.

9. Press the Automatic Creation button.

The automatic creation function automatically creates a group according to the type of material.
Because the helicopter has the two types of materials, or the white part and light blue part (canopy),
two groups are created by the automatic creation function.

10. Select "Group_0" from the group list. Then, press "Group_1" while holding down the control key. You
can select the two groups. In this manner, you can select any desired number of groups from the group
list at one time.

Making the Canopy Semi-Transparent

Make the canopy semi-transparent so that it looks like a windowpane.

1. Select the canopy group on the group control dialog box.
2. Click the Semi-transparent radio button on the material setting dialog box. Now, the canopy is made

transparent, and you can see the interior of the cockpit.

Figure 4-11: Semi-Transparent Canopy

Painting the Cockpit

Now, you can see the interior. Let us paint the cockpit. To select polygons (hidden polygons) surrounded
with other polygons, such as the cockpit, either of the following two methods is used:

Method 1

1. Move the cursor onto the cockpit across the canopy.
2. If you click the mouse, the canopy is selected. Click the mouse without moving it, click it again. Then,

the polygon for the cockpit which located behind the canopy is selected.

Each time you click the mouse without moving it, a polygon behind the currently selected polygon is
selected. This method is effective to select polygons behind transparent polygons as in the case of the
canopy.

Method 2

1. Select a polygon that hides the polygon you want to select.
2. Using the "display off" radio button on the material setting dialog box, temporarily turn off the display of

these polygons.
3. Then, you can easily select any desired polygon because the obstructive polygons are removed.

In either case, you may save the hidden polygons as a group whenever you select them. If you do so, all
you have to do thereafter will be to select that group.
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Pasting a Texture to the Body

1. Load the following file as sample data:
C:\PSXGRAPH\TUTORIAL\MEDITOR\TUTO1\RSD\HELI02.RSD

2. Press the F2 key to select parallel projection mode. Parallel projection is helpful to determine the texture
position precisely. If you press the F2 key again, fluoroscopic projection mode will be selected.

3. Click the Texture radio button on the material setting dialog box.

The file dialog box opens. So, select the HELISIDE.TIM  file, and click the OK button.

Now, the texture layout dialog box appears. This dialog box allows you to specify how the selected
texture should be located on VRAM. Information (filename, pixel size, and mode) related to texture data
is also displayed.

4. Enter the following in the texture layout dialog box:
Texture X: 640
Texture Y: 0

CLUT X: 0
CLUT Y: 480

Then, click the OK button on the texture layout dialog box.

Figure 4-12: Texture Layout Dialog Box

Now, texture data in the TIM file named HELISIDE.TIM  is transferred to VRAM on Artist Board.

The texture mapping dialog box appears on Windows. The semi-transparent texture of the helicopter is
also displayed on the video monitor. This semi-transparent texture is the source texture you are going
to map.

NOTES: Chapter 3, Creating Texture Data (Tutorial) describes how to specify addresses for texture layout.

5. The texture will be projected parallel to the side of the helicopter. Rotate the helicopter so that its side is
facing you, and the head of the helicopter is facing the right side of the screen.

TIPS: Each time you press the Ctrl+A key combination, the helicopter is rotated by 90 degrees. You
can face the side of the helicopter toward you by pressing the Ctrl-A keys several times after the
data is loaded.

6. Select the heliBody group on the group control dialog box.

Thus, all the polygons to which you will paste textures are selected.
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7. Press the Auto button on the texture map dialog box. The position and size of the texture is
automatically changed so that the source texture may be precisely put on the selected polygon.

Polygons that were displayed in red turn yellow. Each polygon presents either of the following states:

• Red polygon: Selected, but not included with the source texture

• Yellow polygon: Selected and included with the source texture

Figure 4-13: Automatically Adjusted Source Texture

8. Click the OK button on the texture dialog box. You can paste the texture to the helicopter body.

TIPS: Depending on the texture and shape of the model, you may have to adjust the position and size
of texture manually. You can move and re-size the source texture using the following keys:

← Move to left → Move to right
↑ Move up ↓ Move down
Ctrl- ← Horizontal shrinkage Ctrl- → Horizontal enlargement
Ctrl- ↑ Vertical shrinkage Ctrl- ↓ Vertical enlargement

9. Check the effect of the texture map by observing the helicopter from various angles. The textures at
both sides of the helicopter must have a protective color.

However, the top and bottom of the texture are distorted, and they are not painted in a protective color.
In parallel projection mapping of a texture, the mapped texture is not distorted if the target polygon is
perpendicular to the mapping direction. As the mapping direction is deviated, distortion of the texture
becomes more outstanding.

To give a protective color to both the top and bottom of the helicopter, you have to prepare textures for
the top and bottom separately, and map them to the top and bottom perpendicularly. This tutorial
omits these steps.

Making the Body Smooth

The last step is to make the body of the helicopter smooth. The following file contains sample data. Load it
by selecting the Open command on File menu.

C:\PSXGRAPH\TUTORIAL\MEDITOR\TUTO1\RSD\HELI04.RSD

1. Select heliBody on the group control dialog box. The helicopter body turns red.
2. Click the Smooth radio button on the material setting dial. The boundaries of polygons for the helicopter

body become less outstanding.
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NOTES: Once polygon selection mode is selected, the smooth-shaded portions are flat-shaded. To
display smooth-shaded polygons, click the Polygon Cancellation button.

This finishes Tutorial 1.

Tutorial 2 (Applied Use)

This tutorial explains the following functions, which were not discussed in Tutorial 1.

• Snap shot
• Decal
• Editing and loading of vertices
• Plunger and brush functions

First, load the following file into Material Editor:

C:\PSXGRAPH\TUTORIAL\MEDITOR\TUTO1\RSD\HELI20.RSD

Snap Shot

Snap shot is the function used to save the image of the video monitor to a TIM file. You can create texture
data easily by editing the TIM file using PhotoShop, which is equipped with the TIM plug-in.

For instance, you may load the helicopter to which no texture is pasted to Material Editor, and take a snap
shot with the side of the helicopter faced to you. Then, apply a protective color to the side view of the
helicopter in the TIM file. If you use this TIM file as texture, you can precisely fit a texture to the side of the
helicopter.

1. Select the Snap Shot command on the File menu. A file dialog box appears. Enter a filename
(FOO.TIM) under which you want to save the file.

2. Using TIMUTIL.EXE  or PhotoShop (with TIM plug-in), display FOO.TIM on Windows screen.

Decal Function

Load HELI20.RSD  and HELI21.RSD  to Material Editor, and compare them with each other. Letters "PS"
and "1995" are texture-mapped on the side of HELI21.RSD . These letters were not written to the texture
image that has the protective color. The letters were put on a separate texture that was then placed on,
and pasted to, the texture with the protective color.

Figure 4-14: Helicopter to which Decal is Pasted

To use the decal function on PlayStation, complete the following steps:

1. Paste the base texture (protective color).
2. Prepare double polygons to which a decal is to be pasted. To obtain double polygons, select a

polygon, and click the Copy button on the material setting dialog box.
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3. Prepare a letter texture that is transparent (STP = 0, (R, G, B)= (0, 0, 0), except for the letters.
4. Paste the above-mentioned letter texture to the front side polygon between the double polygons.

TIPS: There is no function that deletes a copied polygon. In actual data creation, it is advisable to save
the model before copying it.

TIPS: If you click the double polygons, the one at the front side is selected. If you click them twice
without moving the cursor, the inner one is selected.

If the outer polygon is selected, it looks red. If the inner polygon is selected, it does not look red
because it is hidden by the outer polygon. However, if you look carefully, the edges of the inner
polygon appear yellow.

In the above example, the decal function is used to paste textures. If you paste a texture decal to a color
polygon, there will be no difference in colors of the base color of the texture portion and polygons
surrounding it.

Figure 4-15 shows an example in which the same color is applied to the base of the letters and surrounding
polygons without using the decal function. Figure 4-16 is an example in which the decal function is used.

Figure 4-15: Decal Pasted to Color Polygon

Figure 4-16: Use of Decal

Editing and Loading Vertices

"Editing of vertices" is a tool which moves 3D model vertices parallel. Normally, it is used for fine adjustment
of the shape of a model. If you use this function, you can fine-adjust UV values for texture mapping.

For your reference, load the following file:

C:\PSXGRAPH\TUTORIAL\MEDITOR\TUTO1\RSD\BALL00.RSD

Three textures (one rectangular polygon and two trapezoidal polygons) are pasted to this model. You can
quickly perform texture mapping of the rectangular polygon if you use the automatic fine adjustment
function on the texture map dialog box. However, if you use the automatic fine adjustment function for the
trapezoidal polygons, one corner of the texture will extend from the polygon, and the blue boundary cannot
be precisely put onto the boundary of the polygon.
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In such a case, you can perform mapping smoothly if you fine-adjust the UV values by combining the vertex
editing function, and the vertex loading function.

1. Load BALL01.RSD.

2. Select a green polygon, and press the F5 key. The selected polygon becomes in parallel with the
screen.

3. Click Texture on the material setting dialog box, and select SQUARE.TIM as a texture.

4. Without changing the posture of the ball, bring the viewpoint very near to the ball (Shift-S), and click the
Auto key on the texture mapping dialog box.

5. Open the vertex editing dialog box, and click the Vertex Selection button.

6. Drag the polygon at the left top of the selected polygon. The vertex at the right top indicated as a blue
triangle should move. Move it so that the left top of the trapezoid forms a right angle.

TIPS: The screen coordinate system is used for vertex movement. If you hold down the Ctrl key, the
vertex can only be moved up and down. If you hold down the Shift key, the vertex can be moved
right and left. If you hold down both the Ctrl+Shift keys, the vertex can be moved back and forth.

In this example, a rectangle is created if you move the vertices to right and left.

Figure 4-17: Vertex Editing Dialog Box

7. Move the vertex (ID13) at the right top of the trapezoid in a similar manner, and change it into a
rectangle. Thus, the trapezoidal polygon has been changed into a rectangle.

8. Click the Auto button on the texture mapping dialog box again, and press the OK button. Thus, a
texture is precisely pasted to a rectangular polygon.

Figure 4-18: Result of Texture Mapping to Polygon Changed into Rectangle

9. Select the Vertex Load command on the File menu to load BALL01.PLY . The shape of the model is
changed to the original one, and the rectangular texture is precisely fitted to the trapezoid.
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Figure 4-19: Changing Shape of Polygon to Original Shape

TIPS: In addition to fine adjustment of UV values, the vertex loading function can be also used to copy a
material. For instance, suppose a model (model1) of a character in a game is created. Then,
various materials can be set to it. Let us create some different poses (model2, and model3) by
modifying the shape of this model using a modeler. It is very difficult to set the same materials to
these derivative models (model2 and model3).

In such a case, model 1 may be loaded first, and MODEL2.PLY may be loaded by selecting
Vertex Reading. Then, the material of model1 will remain as it is and a posed model model2 will
be created. This method is especially effective when you perform animation using MIMe. This
method is valid only when the shape is changed without changing the number of vertices and
relations of polygon connection.

Plunger and Brush Functions

You may sometimes want to apply the same color to some polygons. You can find the same color in the
Color Setting dialog box, but it is difficult unless you remember RGB values of the original color.

In such a case, you can suck an already painted color using the plunger function.

1. Load the following file:
C:\PSXTRAPH\TUTORIAL\MEDITOR\TUTO2\RSD\BALL20.RSD

The entire ball displayed on the screen is painted in green, excepting a portion painted in white. Let us
paint this white portion in green.

2. Select a green polygon by pressing the Ctrl key and Shift key in polygon selection mode. At this point,
the cross cursor, which has been white so far, turns green. This is the color suck by the plunger.

3. Click the white polygon while holding down the Shift key. Now, the polygon, which has been white,
turns green. This is the brush function.
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Up to this point, we have displayed 3D model data using Material Data through Artist Board. In this chapter,
and chapters that follow, we will describe how to create data that can be displayed on PlayStation. The
format for this purpose is TMD. This format is directly read by the library, and loaded to CD-ROM. It is the
format that should used by the programmer. However, we think it is necessary for an artist to check the
final output.

TMD can be obtained by converting RSD using the 3D graphic tool.

To display TMD, the PlayStation Board and the Programming Tool are needed. Ask a person in charge of
the entire program for cooperation, and perform the following practices.

Creating TMD Data

When RSD data has been created, it can be converted into TMD by executing RSDLINK.EXE. TMD is a
format suitable for executing a game on the PlayStation. It is generally loaded directly to the CD-ROM.
RSDLINK.EXE forms multiple RSD files into one file. Sample data is saved to the RSD and TIM sub-
directory under the HELIVIEW directory. First, move the current directory to the RSD directory by entering
the following after the DOS prompt:

> CD HELIVIEW\RSD

RSD.LINK  is generally executed under the RSD directory.

Give the following RSDs, which are drawn within the same frame, to the arguments of RSDLINK.EXE. In
this example, two arguments are used. If there are a large number of arguments, it is helpful to save them
to a .ARG file. The use when they are formed into a file named HELI.ARG  is also shown below.

> RSDLINK HILI ROTOR

Otherwise,

> TYPE HELI.ARG
  HELI
  ROTOR
> RSDLINK HELI.ARG

As a result, a file named A.TMD is created. Thus, the data can be displayed on the PlayStation.

Options in RSDLINK.EXE

The fundamental options of RSDLINK.EXE are explained below.

Designation of Output Filename
-o outfile-name

Specifies the output TMD filename.

Enlargement/Shrinkage
-s factor

Generates a TMD file by expanding (shrinking) RSD data by the scale factor (rounded to the power of 2)
given by the argument. Therefore, the TMD file thus created has the different scale from the original RSD
data. This option is helpful when the scale of RSD is too small. However, it is recommended to basically
perform re-sizing using RSDFORM.EXE, which will be described in Options of RSDFORM.EXE on page 5-4.
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Creation of Object ID Table
-id model.prj

Reads a project file, and creates an ID header file. It is output as a header file in C language, and used by an
animation program (see Chapter 6, Using the Animation Tool (Tutorial).

For other options, see RSDLINK.EXE in the PlayStation Data Conversion Utilities manual.

Display of Helicopter

Display the TMD file on PlayStation. To do so, you must use a program that loads TMD and draws it. As a
sample program, use a program (such as TMDVIEW5), that displays TMD. Compile it, and load the TMD file
and TIM file for the helicopter, and execute. You can move the helicopter using the controller connected to
the PlayStation board.

Adjustment of Model

You will sometimes find the size too small, or the position is improper when you display TMD. You may see
nothing on the screen because the size is too small. The cause is the too small scale for DXF data when
you originally created the model using the 3D modeler. You did not notice it because Material Editor
displays an object to the optimum size and in the best-suited position. In such a case, re-size or move the
object using RSDFORM.EXE. You can make adjustments after pasting of textures without returning to the
3D modeler.

In addition to parallel translation, RSDFORM.EXE can perform enlargement/shrinkage and rotation for each
axis independently. You can create a shape (mirror image) in a symmetric position. Using this, you can
create similar derivative models from one model.

Options of RSDFORM.EXE

Designation of Output Filename
-o output RSD name

Specify the output RSD name. If you fail to do so, the RSD name will be "a.rsd, a.ply,...". The file will not be
overwritten.

Parallel Translation
-t x y z

This optional switch moves the model parallel in the directions of the X-, Y-, and Z-axes for a distance given
by the argument.

Enlargement/Shrinkage
-s x y z

This option enlarges or shrinks the model in the directions of the X-, Y- and Z-axes by the scale factor given
by the argument. If a negative value is specified, a mirror image with respect to the axis concerned is
created.
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Information Display
-v

This option displays the coordinates of the maximum/minimum and center of each axis before and after
modification. When you want to precisely move the center of gravity to a certain position, you can confirm
the coordinates using this option.

For other options, refer to RSDFORM.EXE in the PlayStation Data Conversion Utilities manual.

If the helicopter in the sample program fails to be displayed properly, make fine adjustment using
RSDFORM.EXE.

To understand the applied use, let us change the shape of the helicopter using the enlargement/shrinkage
function.

> RSDFORM -o HELI9 -s 1 0.5 1 HELI8.RSD

If you enter the following, a vertically crushed helicopter (HELI9.RSD ) will be created:

> RSDFORM -o HELI9 -s 1 0.5 1 HELI8.RSD

If you enter the following, a transversely crushed helicopter (HELI10.RSD ) will be created. Because the
model is rotated (by _1 turn) in the direction of the Y-axis, the front and rear are reversed.

Using RSDFORM.EXE, try to create various helicopters.
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For this tool, you can use only the left-hand button of the mouse. If you want to quit from the tool, you may
select Quit on the File menu.

Basic Operation of Model

Displaying a Model

Start animatio.exe .

Select Open Project on the Project menu. The following dialog box appears:

Figure 6-1: Opening Project

Double-click the directory field to move the current directory to C:\PSXGRAPH \TUTORIAL\ANIM\TRY1 .
When the suitable directory is selected, you can manipulate the Open button. At this time, red letters
model.prj , object.prj  are displayed. They indicate that the current directory is the Project directory.
Do not select it. Click the Open button, and the dialog box disappears. Thus, the project has been opened.
Now, the directory where you will perform work is determined. In this status, no model is displayed on the
screen.

Now, select the Open command on the File menu. The following dialog box appears:

Figure 6-2: Opening HRC

Select try.hrc  displayed in the file field. When the file is selected, you can use the Open button. Click the
Open button. Then, the dialog box disappears, and the general window appears. Thus, the HRC file has
been opened. Do you see a helicopter? The red, blue, and green lines indicate the positive directions of the
X-, Y-, and Z-axes of the world coordinate system.
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Figure 6-3: Open HRC (Helicopter)

This helicopter is used in the following description. When you quit from the tool, do not save the HRC file.

Creating a Model

This section describes the procedure for model selection, parallel translation, rotation, and
enlargement/shrinkage.

1. Selecting a model

Put the mouse cursor on the helicopter, and click it. A red rectangular parallelepiped covering the
helicopter appears. It is called a bounding box. This finishes the selection of an object using the mouse.

Figure 6-4: Selected Helicopter
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2. Parallel translation

Put the mouse cursor on the bounding box, and drag the mouse cursor. The bounding box moves
parallel to the movement of the mouse. Release the mouse button when the bounding box is moved to
a suitable position. The helicopter is displayed in the position of the bounding box.

Figure 6-5: Parallel Translation

While holding down the Shift key, put the mouse cursor on the bounding box, and drag the mouse
toward the front. You will see the bounding box moving toward the front. If you want to move it
backward, drag the mouse backward. This is the parallel translation of the object. Strictly speaking, the
object is moved in parallel with the viewpoint coordinate system. Therefore, when an object that is not
located at the center of the screen is moved to the front or rear, it looks as if it is moving along a radiant
line drawn from the center of the screen while its size is changed.

3. Rotation

Put the mouse cursor to a vertex of the bounding box, and drag the cursor. The bounding box rotates
as the mouse moves. Release the mouse button. The helicopter is displayed in the same posture as
the bounding box. This method may be used to adjust the posture roughly.
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Figure 6-6: Rotation by Selection of a Vertex

Then, put the mouse onto a line of the bounding box, and drag it. The bounding box rotates around an
axis parallel with the line. Release the mouse button. The helicopter is displayed in the same posture as
the bounding box. This method may be used to adjust the posture.

Figure 6-7: Rotation by Selection of a Ridgeline

This is the rotation of the object. The center of rotation is always the center of the bounding box. In the
first method, the direction of the rotation axis always changes. In the second, it is constant until you
release the mouse button.

4. Enlargement/shrinkage

While holding down the Ctrl key, put the mouse cursor onto the vertex of the bounding box, and drag
mouse so that it may go farther from the center of the bounding box. The bounding box is enlarged as
the mouse is moved. When the size is almost doubled, release the mouse button. The helicopter of the
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same size as the bounding box is displayed. If you want to shrink, drag the mouse so that it may be
brought near to the center of the bounding box.

Figure 6-8: Enlargement by Selection of Vertex

While holding down the Ctrl key, put the mouse cursor to a plane of the bounding box, and drag the
bounding box. If you drag the plane away from the bounding box, the plane is drawn out and enlarged.
If you bring it near the center, the object shrinks as if it were crushed by that plane.

Figure 6-9: Enlargement/Shrinkage by Selection of a Plane

This finishes enlargement and shrinkage of an object. The first method is proportional enlargement and
shrinkage not dependent on the direction. The second method is enlargement and shrinkage having a
direction. The scale factor for enlargement and shrinkage is 1/4096 time to about 8 times (8 times to
1/4096 time) because of the restrictions imposed by PlayStation.

These are simple functions of the tool. Please understand that data are manipulated inside the
computer with ease with which you hold a cup.
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5. Manipulation by entry of numerical values

Let us see how to manipulate an object by specifying numerical values, such as rotation angle and
amount of parallel translation. Close the file in the status 4), and open the helicopter again.

When it is opened, call up the tool palette by selecting the Tool Palette command on the Tool menu.

Figure 6-10: Manipulation by Entry of Numerical Values

To enter numerical values, follow these steps:

1. Select an object.

2. Specify the method of operation.

3. Enter numerical values.

4. Click the OK button.

1. and 2. may be performed in the reverse order. In step 3, parallel translation is performed using the
current position as starting point. A negative value can also be specified. For rotation, you specify an
angle. The position of the object is changed from the current posture. You can also use a negative
value. For enlargement and shrinkage, 1.0 does not change the size. You must not specify a negative
value.

Fundamental Operation of Camera

The image displayed on the window is relayed through an imaginary camera. You will see "General
[ISOMETRIC CAMERA]" on the title bar on the window. It indicates that an image as seen from the
isometric camera is displayed on the general window. This section describes how to change screen display
on the window by pushing, pulling, swinging up and down, to right and left, and tilting the imaginary
camera. As in the previous section, we will use the helicopter. Open the HRC file. If the helicopter is not in
the center of the screen, move it by following the procedure described in the previous section.
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Figure 6-11: Fundamental Operation of Camera

Pushing and Pulling the Camera

To bring the camera near the helicopter, strike the space bar. Each time you strike it, the camera moves
forward for 1000. If the camera goes too far, and passes by the helicopter, nothing will be displayed. To
move back the camera, strike the space bar while holding down the Shift key. Each time you strike the
space bar, the camera moves back for 1000. If you move back the camera to a certain point, you will see
the helicopter. Holding down the space bar does not move the camera forward or backward.

Figure 6-12: Pushing/Pulling the Camera (Large)

Move the camera to a position where it just passes by the helicopter. To move the camera close to the
helicopter from this position, strike the space bar while holding down the Ctrl key. Each time you strike it,
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the camera approaches for 100. To move the camera backward, strike the space while holding down the
Shift and Ctrl keys. Each time you strike the space bar, the camera is moved backward for 100.

Figure 6-13: Pushing/Pulling Camera (Small)

Swinging the Camera Up and Down, and to Right and Left

The direction of the camera is determined by the cursor keys. Strike the right cursor key. Now, you will see
the right portion of the helicopter. To change the direction to the left, strike the left cursor keys. Do the
same to move the camera up and down. Each time you press the cursor key, the direction of the camera
changes by 10 degrees. The direction will not continue to change if you hold down the cursor key.
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Figure 6-14: Swinging the Camera Up and Down, and to Right and Left

Holding down the Ctrl key, strike the right cursor key. The direction changes only a little. To fine-adjust the
direction of the camera, strike the right or left cursor key while holding down the Ctrl key. Each time you
strike the cursor key with the Ctrl key held down, the camera rotates by one degree.

Tilting the Camera

You can tilt the camera as you tilt your head when you see a tilted object. Put the camera away from the
helicopter to such a point where you can see the helicopter easily. To tilt the camera to the left, strike the
left cursor key while holding down the Shift key. The helicopter is now tilted. To tilt it to the right, strike the
right cursor key while holding down the Shift key. Each time you strike the right or left cursor key, the
camera is tilted by ten degrees.
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Figure 6-15: Tilting the Camera

Now, you can perform fine adjustment. While holding down the Shift and Ctrl keys, strike the right or left
cursor key. In this case, the camera is tilted by one degree.

The simplest method of handling the camera has been described in this chapter. You do not have to
memorize the Shift key and Ctrl key combination, etc. Practice repeatedly until you learn them by heart.

Import of DXF File

This section describes how to load a DXF file, and convert it into an RSD data format file using this tool. You
do not have to read this section, and you may proceed to the next chapter if:

• You do not have a DXF file.
• You do not have to use a DXF file.
• You use a CG software program capable of handling RSD data format.
• You know how to use DSF2RSD.EXE.
• You know how to use DXF2RSDW.EXE.

Animation Tool performs conversion by calling up DXF2RSD.EXE. This is a simplified method, and it does
not support all the functions of DXF2RSD.EXE. It is more convenient to use DOS for batch processing
when converting a plural number of files. If you want to call up DXF2RSD.EXE from this tool, you must
install the DXF2RSD.EXE file to the sub-directory \RSXGRAPH\BIN in drive C beforehand. You cannot call
this file from any other directory.

Before starting the operation, cancel DOS prompt, DOSEXEC, etc. If you have ionized DOSEXEC, you
cannot start DXF2RSD.EXE.

In this chapter, you do not use the helicopter. If it is displayed on the screen, close HRC by selecting the
Close command on the File menu. Get a floppy disk containing a DXF file.
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Opening a Project

Open C:\PSXGRAPH\TUTORIAL\ANIM\TRY1 . To determine the destination address for saving of data
after conversion, you must open the project before import. If you found the helicopter displayed on the
screen, you do not have to do so because the project is already open.

Importing

Select the Import command on the File menu. The following dialog box appears:

Figure 6-16: Import

Insert the floppy disk containing a DXF file to the floppy disk drive (e.g., drive A). Select drive A from the
drive list. If the DXF filename (e.g., BALL.DXF ) is displayed in the file field, select it. If not, move the
directory. BALL.DXF located in the root directory of drive A. Designate the filename after conversion as
BALL.RSD, and click the Import button. The dialog box disappears, and block DOS screen indicating the
progress of conversion, etc. appears. When conversion is completed, the dialog box appears again. This is
instantly done if the amount of data is small.

Data after conversion is saved to the RSD directory of the currently open project.

This finishes import of the DXF file. This operation does not display data after conversion. If you want to
display it, you have to add and save an object as described in the next section.

When saving a DXF file, you have to be careful about the position and posture of a model with respect to
the modeler coordinate systems (object coordinate system, local coordinate system, body coordinate
system, etc.). As for the position, the result of import may extend beyond the General window, or display off
center. This causes no problem because you can move it using the function of parallel translation. However,
if the posture is improper, you cannot correct it using the tool. For instance, if the front, rear, right, left, top,
and bottom of the helicopter are tilted with respect to the modeler coordinate system, the tilted helicopter
will be displayed inside the bounding box as a result of import. It is very difficult to adjust the posture of the
helicopter in this status. Before saving the DXF file, be sure that the front, rear, right, left, top and bottom
are parallel with the modeler coordinate system.

Adding and Saving an Object

The helicopter was displayed when you opened the HRC file in Subsection 6.1.3. However, this does not
mean that helicopter shape data are saved in the HRC file. The role of the HRC file is to describe the
relations with other objects, such as the objection position, posture, and hierarchical structure. Therefore,
nothing would be displayed without the HRC file because it cannot be determined where and in what
posture the object exists. This section describes how to add and save an object to the HRC file using
ball.rsd  created in the previous section.
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1. Opening a project

Open C:\PSXGRAPH\TUTORIAL\ANIM\TRY1 .

You do not have to call up this file if you did not discontinue work described in the previous section.

2. Create a working space

Select the New command on the File menu. The general window appears. The object is not displayed
yet.

Figure 6-17: Creating a Working Space

.

3. Adding an object

Select Add Object from the File menu. The following dialog box appears:

Figure 6-18: Adding an Object (1)
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Select ball.rsd  imported earlier, and click the Add button. The ball.rsd  is displayed in the lower
field. Click the Done button. The following dialog box appears:

Figure 6-19: Adding an Object (2)

The RSD filename is displayed in the left field on the dialog box. The right field is used to specify the
object name. On the screen, Ball is displayed as object name. For the time being, leave the object
name as it is. Click the Set button. A ball is displayed on General window.

Figure 6-20: Added Object

4. Saving an object

Select the Save As command on the File menu. The following dialog box appears:
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Figure 6-21: Saving an Object

Enter the HRC filename to the box beside Save As:. Type BALL.HRC. If you click the Save button, a
new HRC file saving the position and posture of the ball is created.

This completes adding and saving of an object. The HRC file thus created can be opened if you follow the
same procedure you followed to display the helicopter for the first time. Of course, you can perform steps 3
and 4 for an open HRC file.

Creation of Hierarchical Structure

Figure 6-22: Creating a Hierarchical Structure

Open C:\PSXGRAPH\TUTORIAL\ANIM\TRY2 , and then open ROBOTARM.HRC. A robot arm appears on
the screen. The same image can be obtained if you assemble parts, such as the arm and mount, to get the
same layout. However, it is too great a burden to do so each time you move the arm. To move the lower
arm and hand according to bending of the elbow, you may use the hierarchical structure.

The root of a hierarchical structure is always the world coordinate system. Its child is for the mount, the
child of the mount is for the shoulder, and the child of the shoulder is for the upper arm... The shoulder is, of
course, a joint. In PlayStation, a joint is expressed in terms of parameters, such as transformation matrix.
The parameters serve as the reference (coordinate system) in determining the position and posture of the
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object which is the child. In this too, the style of the object, which can be treated as transformation matrix,
is called the origin. Normally, the origin is not displayed. To see it,  select Show Origin on the View menu.
The origin is indicated by red, green, and blue orthogonal arrows. The red, green, and blue arrows stand for
the X-, Y-, and Z-axes of the origin coordinate system, respectively.

The origin has a style of an object which can be handled as described above. However, it has no color or
shape when transferred to PlayStation. So, it uses hardly any memory space as compared with a model.
The polygon indicator does not count the number of polygons in the origin.

In this sample, there is no origin where the elbow should be located. Let us apply an elbow, and complete
the robot arm.

Creating an Origin

Select Create Origin on the Tool menu. The following dialog box appears. Type elbow  to name the object
as elbow. Then, click the OK button.

Figure 6-23: Creating an Origin (1)

The origin is displayed at the zero point of the world coordinate system. It is the elbow. Let us move the
elbow to its position. Select the Front command on the Window menu to call up Front window.

Figure 6-24: Creating an Origin (2)

Before selecting the elbow, select the Origin icon on the tool palette, to restrict the object of manipulation to
the origin. (While the origin icon is selected, there is no fear for selecting a model or camera by mistake.)
Then, select the parallel translation icon to move the origin to the position of the arm without rotating it.
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Figure 6-25: Restricting Object of Manipulation

During parallel translation on Front window, the default front camera coordinate system is in parallel with the
world coordinate system. Therefore, if the object is moved up and down and right and left on the Front
window, the object moves on a plane which is parallel with the XY plane of the world coordinate system
containing the center of the bounding box for the object. Because the center of the bounding box for the
elbow is put on the XY plane of the world coordinate system, the elbow does not move apart from the XY
plane of the world coordinate system as long as it is dragged up and down and right and left. Each axis of
the elbow is made parallel to the axes of the correspondent world coordinate system. When you create
other joints, be sure that their directions are the same. If their directions differ, trouble will occur when they
are manipulated. Furthermore, additional time will be needed when driving the joint structure using the
program.

Linking

In this status, the elbow is put to its position, but the elbow and the lower portions will be left unmoved if
the upper arm is lifted by turning the shoulder. So, let us employ the hierarchical structure. Select the Link
icon indicated by the parent and child mark on Tool Palette. If elbow has not been selected, select it. To do
so, select the origin icon indicated by a coordinate system mark, and then select elbow so that you do not
select the upper arm or forearm by mistake. (At this time, the first clicking makes the window active, and
the second clicking selects the object. This procedure is always followed whenever you return from Tool
Palette.) The select object (elbow) is the child.

Figure 6-26: Linking

Then, select the parent. The parent of the elbow is the upper arm. Select the model icon indicated by a
cube, and then select the upper arm. As long as the model icon is selected, there is no fear for selecting the
camera or origin by mistake. Linking is successful if the upper arm is instantaneously wrapped with the
green bounding box. When selecting the parent object, you may slowly press the mouse button and release
it to watch it. You will not see the green bounding box even if you select a parent object.

Finally, link the forearm and elbow. In this case, the forearm is the child. While the selected object (elbow)
indicated by the red bounding box exists, parent object selection mode is selected. Click the portion where
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no object exists to cancel this mode. Then, select the forearm. The forearm is the child. Then, select the
elbow. When they are linked, click the Link icon to turn it off. The forearm and the subsequent objects are
linked beforehand.

This completes the robot arm. Save the data to the HRC file immediately. Make it a rule to save data to a file
whenever you complete an important job. This tool does not warn you if you fail to save data to an HRC file.

Check of Linking

To check the hierarchical structure, select Object Browser on the Tool menu. You should select Elbow
beforehand. The following dialog box appears:

Figure 6-27: Check of Linking

On the left, the World, Base, Shoulder, UArm, and Elbow buttons are located from the top to the bottom in
that order. The red frame of the Elbow button indicates that it is currently selected. They constitute the
hierarchy of the objects above Elbow. The left field indicates Forearm, which is the child of Elbow.

If you click any of the buttons on the left, that object is selected. You may click them to circulate the
hierarchy. If you select a name indicated on the right, and press the Select button, or if you double-click the
name, the object is selected. You can use this function to descend the hierarchy. This is a way of selecting
an object. If numerous objects are used, it will be difficult to select a target object without touching other
objects. In such a case, this browser function will be helpful. Now, click the Cancel button to close Object
Browser.

Cancellation of Linking

Let us examine the procedure for cancellation of linking so that you can follow it when you make a mistake.
The Unlink icon is indicated by a highlighted mark shown in the figure below. Select that icon.
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Figure 6-28: Cancellation of Linking

To cancel linking, select an object, and click it again. The selected object is separated from the parent. You
do not have to select the parent object at this time. The objects (child) below the selected object in the
hierarchy are maintained as they are. Now, separate the elbow from the upper arm. Select the elbow if it
has not been selected. Cock the elbow again after selecting it. It is instantaneously covered by the
bounding box. The forearm, wrist, and hand which are located below the elbow remain the child and
grandchild, etc. The world coordinate system serves as the parent for the separated object as was the case
when the object was added and saved for the first time. You cannot break these relations. Call up Object
Browser, and click the world button. If linking is successfully canceled, the elbow should be displayed in the
right field.

Moving the Robot Arm

Close the file once. Select Close on the File menu. Then, open ROBOARM.HRC. This is a finished robot arm.
Let us bend the elbow. Select Origin on the Tool Palette so that you do not select the upper arm or
forearm. The elbow has only one rotation axis. If an object is to be rotated around only one axis, it is
convenient to inhibit rotation around other axes. Because the Z-axis is used as the rotation axis for the
elbow, select Z Only on the Tool Palette. If the rotation axis is definite, you do not have to set the starting
point for dragging to a ridgeline which is parallel with the axis of the bounding box when you are going to
start rotation. The starting point for dragging may be any place on the bounding box. Therefore, you can
rotate the elbow on any window. It may seems the same with the helicopter even when the elbow is
rotated. However, if the mouse button is released, the elbow rotates and all the objects below the elbow in
the hierarchy move accordingly. Try to move other joints. You will now understand why the directions of the
origins were made the same. If the directions of the origins for the joints are different, you will have to
manipulate the Tool Palette.
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Figure 6-29: Moving the Robot Arm

Another Method

Let us try to extend the mount upward. On the General window, drag the mouse using the top of the pillar
as a starting point. When the mount has been extended, rotate the shoulder on Front window. You will see
that the shape of the bounding box is distorted. The degree of distortion is proportionate to how long the
mount was extended. Release the mouse button when it is put to a portion where distortion is extreme. If a
model with a child is enlarged or shrunk in this manner, the child objects are adversely affected. This is
attributable to the library specification of PlayStation. You cannot avoid it. Close ROBOARM1.HRC, and open
ROBOARM2.HRC. Now, the child and grandchild are not affected even if you rotate the shoulder. The
differences between the hierarchical structures of ROBOARM1.HRC and ROBOARM2.HRC are shown below:
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Figure 6-30: Hierarchical structures of ROBOARM1.HRC and ROBOARM2.HRC
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If a hierarchical structure contains a model that is likely to be enlarged and shrunk, it is essential not to
create a child or grandchild below that model in the hierarchical structure.

Creation of Animation (Sequences)

This section describes how to create an animation.

Let us see what meanings the terms animation and sequence have. In a motion picture, a picture of an
actor's back view and a zoomed picture of his face as it is turned are taken separately, and connected
later. The tool provides the concept of sequences so that an animation can be made up of some portions.
That is, sequences constitute an animation, and a series of sequence is called an animation. It is not difficult
to understand. A part of animation can be an animation itself. You may think that Sequence = Animation.

Let us see some examples.

First, open the project C:\PSXGRAPH\TUTORIAL\ANIM\TRY3 , and open TE.HRC.
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Figure 6-31: Sample Data “Hand”

The hand shown on the screen has the following hierarchical structure. (It is shown in General, Left Side,
and Front windows in Figure 6-31.) As in the example of the robot arm, the joint of each finger is expressed
as origins so that the movement may be transmitted from the root of each finger to the tip.

Figure 6-32: Hierarchical Structure of Sample Data "Hand" 1
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Figure 6-33: Hierarchical Structure of Sample Data "Hand" 2

Using the data on the hand, let us create an animation of “jaankeen.”

Making Preparations to Create Sequences

Let us create sequences first. It is advisable to use names representative of the animation as sequence
names so that they can be easily identified.

The project C:\PSXGRAPH\TUTORIAL\ANIM\TRY3  contains some sequences.

N-P-N: From lowering of the hand to show "paper", to raising of the hand

N-C-N: From lowering of the hand to show "scissors", to raising of the hand

N-G-N: From lowering of the hand to show "stone", to raising of the hand

APPEAR: The hand walks, and appears.

DISAPP: The hand jumps to retire.

In addition to these, let us create a sequence in which the hand is swung twice with a cry "jaankeen".

Select the New Sequence command on Project menu. Type JAANKEEN in place of sAMPLE01 on the
dialog box, and click the Create button. The dialog box disappears, and Keyframe Recorder appears.

Now, preparations for creating a sequence named JAANKEEN have been made.
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Figure 6-34: New Sequence Dialog Box

Creating a Keyframe

Before creating an animation, you have to create keyframes. An animation is created by interpolating the
created keyframes.

When the Keyframe Recorder is displayed on the screen, the slider is put to 0.

Figure 6-35: Keyframe Recorder Immediately after Calling

To this position, create the pose of lowering of the hand as keyframe. Currently, the hand shows "stone".
Rotate the origin named JNT0 located at the highest level in the hierarchical structure at the position of the
wrist by 30 degrees. You may use the function of rotation by numerical values. This is the fundamental
position.
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Figure 6-36: Fundamental Position

NOTES: This does not complete preparation of the keyframe. To create a keyframe, it must be saved. If
you fail to save it, the created pose is not be saved.

To save the keyframe, turn on the Propagate button. (It is turned on when Keyframe Recorder is called up.)
Be sure that the Create button is green, and press the Record button (marked with a red circle). Do not
forget to turn on the Propagate button in the above procedure. If the Create button is not green, click it
once. Press the Record button, and the green keyframe marker is indicated at the "0" position.

Figure 6-37: Keyframe Recorder Immediately after Saving of First Keyframe

Now, this keyframe is finished.

Let us create a keyframe for lowering the hand.

Move the slide on Keyframe Recorder to the "20" position. Note that you have to move the slider to the
position of the keyframe that you are going to create before starting work. If you move the slider without
saving the created keyframe, all the work will end up in a failure.

Let us create a pose of lowering the hand by rotating JNT0 by -90 degrees around the Z-axis.
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Figure 6-38: Position of Lowering Hand

Save the keyframe again. Now, be sure that neither the Create button, nor the Kill button on the screen is
selected. Currently, the Create button may be displayed in green. Then, you should click the Create button
so that both of these buttons may be indicated in yellow. If the Propagate button is on, turn it off so that
unnecessary keyframes are not created. As you did earlier, press the Record button. Now, the yellow
keyframe marker is indicated at the "20" position. Thus, another keyframe has been saved.

Figure 6-39: Keyframe Recorder Immediately after Saving of Second Keyframe

In a similar manner, move the slider on Keyframe Recorder to the "40" position, and rotate the hand around
the Z-axis by 60 degrees from the original position to get the same pose which existed when TE.HRC was
opened. This is the starting position for lowering of the hand for the second time.
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Figure 6-40: Starting Position for Lowering Hand Second Time

Figure 6-41: Keyframe Recorder just after the Third Keyframe Registration

At the "60" position, create a pose for end of lowering of the hand for the second time. This pose is the
same as that for the end of lowering of the hand for the first time. So, all you have to do is to copy the
keyframe at the "20" position to the "60" position. Click the keyframe marker at the "20" position, and move
the slider to the "20" position. While holding down the Ctrl key, drag the slider to the "60" position, and
release it.

Figure 6-42: Keyframe Recorder with Slider Moved to "Copy Destination" Position

Now, press the Record button. The keyframe has been copied.

Figure 6-43: Keyframe Recorder Immediately after Saving of Fourth Keyframe

In the similar manner, copy the keyframe at the "0" position to the "80" position.
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Figure 6-44: Keyframe Recorder Immediately after Saving of Fifth Keyframe

Thus, we have created five keyframes. Return the slider to the "0" position, and press the > key to play the
animation. Have you successfully created an animation which swings the hand to play "jaankeen?”

Let us see differences among the green, yellow, and red keyframe markers. (You have not seen the red
keyframe marker. It is displayed if you press the Record button when the Kill button is displayed in red.)

The green keyframe marker indicates that the object or origin appears (is created) in that frame. The red
keyframe maker indicates that the object or origin appears (is created) in that frame. The yellow frame
marker indicates that the object or origin appeared (was created) in any previous frame. In most cases,
therefore, a sequence is so crated that the marker for the first keyframe may be green, and the marker for
the subsequent keyframes may be yellow. Unless you create an object or origin, it will not appear on the
screen even if you try to display that data on a program displayed on PlayStation. Remember that you
turned on the Propagate button when you created the keyframe at the "0" position. You did so to create
not only JNT0, but objects or origins below JNT0 in the hierarchical structure.

Bear in mind that you must create a parent for data having a parent-child structure before or at the same
time that you create a child. Otherwise, an error will occur when you try to load TOD data created from that
sequence into a display program for PlayStation to display it on the screen.

Saving to a TOD File

Save the created animation to a TOD file. It is advisable to use a name representative of the animation as
the TOD filename. Let us use JAANKEEN.TOD. (Be careful because there is a file with a similar name
JAANKEN.TOD.) Enter 0 into Start and 80 into End, and press the Export button.

Figure 6-45: Export TOD Dialog Box

Now, JAANKEEN.TOD containing animation data for total eighty-one frames has been created under the
directory C:\PSXGRAPH\TUTORIAL\ANIM\TRY3\TOD .
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Viewing TOD Data

To view the TOD data you created, you need a programmer tool. For this purpose, you can use TODVIEW,
which is a sample program used to view TOD data. (It is saved as C:\PSX\SAMPLE\GRAPHICS\TOD-
\TODVIEW.) Let us view the TOD data using TODVIEW.

Sample data provided together with TODVIEW is the same data as you created by following the procedure
described above. Referring to the attached README, execute the program. On the monitor, you will see
the hand showing "stone" swing twice with a cry "Jaankeen".

Among the data under the directory, the following data are created by the 3D graphic tool, and transferred
to the program:

• TOD data (JAANKEN.TOD in TODVIEW)
• TMD data (TE.TMD in TODVIEW)
• TMD ID list (TE.H  in TODVIEW)
• TIM data (Not used in TODVIEW)

If you replace these files with ones you created by yourself, you can check the details of the data you
created. Among these data, you already created TOD data in the above-mentioned practice. However, you
must get 3D model data (TMD data/TMD ID list) used in the created animation. To create these data, select
the TMD command on the File menu. For details, see the description of Export TMD in Chapter 9,
Animation Tool (Reference). Now, the TMD data and TMD ID list are created.
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Chapter 7:
Using MIMe Animation
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What is MIMe Animation

How was the famous dinosaur in the demonstration program for PlayStation created? Even if you use the
techniques described in Chapter 6, you cannot smoothly change the shape of the mouse, and move the
feet without dislocating any joint. The fierce expressions and walking patterns are synthesized real-time. It is
an animation technique unique to PlayStation called MIMe animation. It has great power of expression, and
is suitable for soft expressions. However, it imposes a great load on execution. The performance of
PlayStation is essential to this animation technique.

Let us see the principle of MIMe animation.

Principle of MIMe Animation

In MIMe animation, the coordinates of each vertex of a 3D model are moved separately in real-time (see
Note). Furthermore, its movement is controlled using parameters. So, you can simulate a wavering motion,
and a fist delicately bouncing after hitting an object. This method greatly differs from the conventional
method of animation in which the position (using a set of vertices) of vertices of an object is moved from one
keyframe to another.

Figure 7-1: Principle of MIMe
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NOTES: The concept of MIMe is not restricted to vertices. It can be applied to variations, such as normal,
angle, and UV coordinates of a texture. For simplicity, only vertices are discussed in this section.

Keyframes are also used in MIMe animation. In MIMe, indefinite patterns are created by interpolating
keyframes by applying weight factors to each keyframe, and obtaining weighted average (multiple-
interpolation). "To obtain weighted average" or "to perform multiple-interpolation" means to create a
average frame by blending two or more keyframes at various ratios. MIMe animation performs such
interpolation real-time (see Figure 7-1).

To perform interpolation of two keyframes, it is convenient to have finite differences rather than hold two
keyframes as they are. MIMe uses one original model, and data on finite differences from the original model,
and performs interpolation using them.
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Imagine weight factors arranged according to the time series. It will constitute a waveform, and expresses
the change of ration at which particular keyframes are blended. This waveform data is called keyframe
control waveform. It is an important parameter which characterizes movement.

For instance, if the weights of two keyframes change as shown in the left view in Figure 7-2, the effect will
be the same as that of a linear keyframe animation. The right view shows spline-interpolated keyframe
animation.

Figure 7-2: Control Waveforms

Suppose a certain keyframe has a control waveform shown in the figure below, a real effect of inertia can be
expressed because the object returns after going a little too far.

Figure 7-3: Control Waveform with Overshoot

Thus, MIMe expands the range of keyframe animation, and expresses more complicated movement.

Data Necessary for MIMe

MIMe animation requires the following data:

• 3D model (original model)
• Keyframes (modified modes), and data on finite differences from the original model
• Control waveform data (as many as the number of the modified models)

How many keyframes there may be, only one original model is stored in memory. Models in other keyframes
can be restored using the original model and finite differences. In this manner, MIMe is advantageous in
memory efficiency.

Creation of model data for MIMe animation begins with creation of some poses. Let us see the procedure
for creation of MIMe data using sample data. The directory for the sample data is TUTORIAL\MIME.
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Creation of Boxer

Create a 3D model man as the original model for MIMe, and let him fight as a boxer. You may use the
sample model. The directory is TUTORIAL\MIME\RSD. Some DF files and RSD data are saved under this
directory.

Figure 7-4: Boxer

The procedure for actual modeling is described below.

First, create the 3D model of the boxer as one object. That is, create a shape which is not cut off at the
joints as shown in Figure 7-4, and save it as one DXF file.

1. Create an original mode, which is a fundamental pose, and save it as DXF. Name the file as
BOXER0.DXF. At the same time, save the format of the modeler. The original model will be loaded
many times because it is modified into various models.

2. Based on the original model, create a showy pose by changing the positions of the arms. Repeatedly
move the vertices and polygons, and save the result as BOXER.DXF. This is called the modified model.
It resembles a keyframe.

3. Create another modified model. It is advisable to load the original model again for modification. Modify
the original model in a manner different from step 2 above, and save it as BOXER2.DXF.

TIPS: MIMe is suitable for soft movement. A real effect can be obtained if you change the swelling of the
muscles according to the positions of the arms.

4. By repeating the procedure described in step 3 above, create as many modified models as necessary.
In this example, four models (BOXER1.DXF through MOXER4.DXF) are created.

5. Now, convert the original models and modified models into TMD.

> DXF2RSD -g BOXER?.DXF

Thus, five RSD data files have been created. To express smooth surfaces, smooth shading (-g  option) was
performed. Give names to RSD data, and convert them into TMD.

> RSDLINK -o BOXER0.TMD BOXER 0

> RSDLINK -o BOXER1.TMD BOXER 1

> RSDLINK -o BOXER2.TMD BOXER 2

> RSDLINK -o BOXER3.TMD BOXER 3

> RSDLINK -o BOXER4.TMD BOXER 4
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We paste no texture in this section. MIMe animation can be created by creating a model with textures using
Material Data. At this time, you may paste textures to the original model. MIMe modifies the textures real-
time.

Now, all the model data for MIMe has been prepared. Let us give finite differences. MIMEFILT.EXE  is a
tool for that purpose.

MIMEFILT.EXE

MIMEFILT.EXE  outputs the finite differences for vertex data and normal data based on the original TMD
file and modified TMD file(s). This program is used in the following manner:

> MIMEFILT -n BOXER0.TMD BOXER1.TMD BOXER2.TMD BOXER3.TMD BOXER4.TMD

As a result, the BOXER0.VDF and BOXER0.NDF files are created. They are the vertex difference file and the
normal difference file. These files contain the array of differences from individual X-, Y-, and Z-coordinates
(components). (The number of finite differences has been a little reduced.) For details, see MIMEFILT.EXE in
the PlayStation Data Conversion Utilities manual.

The n-  option is used to specify normal MIMe. Normal MIMe synthesizes luster and shadows on the
surfaces real-time.

Thus, finite difference data has been prepared.

Execution of MIMe Animation

In addition, MIMe animation requires control waveform data. It determines at what speed each modified
model changes its shape, and at what ratio modified models are synthesized. Generally, control waveform
data is defined as a waveform in the range between 0 and 1. Notice that 1 is expressed as 4096 because
fixed-point calculation is performed inside PlayStation. An example of a control waveform is given below. It
is actually used to express the blinking of eyes of the dinosaur.

static int blinktable[120] = {
   0, 1024, 2048, 3072, 3072, 3072, 3072, 2048, 2048, 2048,
1024, 1024, 1024,  768,  768,  512,  256,  128,    0,    0,
   0,    0,    0,    0,    0,    0,    0,    0,    0,    0,
   0,    0,    0,    0,    0,    0,    0,    0,    0,    0,
   0,    0,    0,    0, 2048, 4096, 4096, 4096, 4096, 4096,
3072, 2048, 1024,    0,    0,    0, 2048, 4096, 2048,    0,
   0,    0,    0,    0,  512, 4096, 3072, 2048, 1024,  512,
   0,    0,    0,  512, 4096, 3072, 2048, 1024,  512,    0,
   0,    0,    0,    0,    0,    0,    0,    0,    0,    0,
   0,    0,    0,    0,    0,    0,    0,    0,    0,    0,
   0,    0,    0,  512, 1024, 2048, 2048, 2048, 2048, 2048,
1024,  768,  512,  256,    0,    0,    0,    0,    0,    0

};

To move the boxer, you need a program. You can utilize the sample program MIME5 attached to Program
Tool. Ask a person responsible for the entire program for cooperation, and execute it on the PlayStation
board. Make sure that the boxer lands a punch according to the controller input. If you press two or more
buttons, a shape created by synthesis of some poses is obtained. This is the effect of multiple-interpolation
of MIMe. In this manner, MIMe animation allows creation of indefinite patterns by blending keyframes at any
desired ratio.

In the sample program MIME5, step functions are entered as controller input, and a control waveform is
used for convolution, and the result of convolution is used as a weight factor. That is, the two waveforms
are multiplied, and a control waveform for interpolation is generated real-time as shown in Figure 7-5.
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Figure 7-5: Control Waveform and Convolution

The program becomes simple if convolution is employed to respond to controller input. In the case of MIMe
animation which does not resort to the controller, the control waveform is directly used as a weight factor.

More about Using the 3D Modeler

You must use care when using the 3D modeler to create MIMe model data. To change the shape of a 3D
model, you have to move the vertices, and you must not increase or decrease the number of vertices.
Furthermore, you must not change the order of vertices because correspondence of vertices can only be
known from their order. This may seem to be a strict restriction. However, no problem will arise as long as
you simply move vertices and planes (sets of vertices).

Fundamentally, MIMe performs linear interpolation. If you directly apply rotary motion as described in the
example of "jaankeen" in Chapter 6, a problem, in which figures will become too short during execution, will
arise.

In such a case, you will have to take the following actions:

1. Insert a keyframe for interpolation.
2. Perform curve-interpolation (spline, etc.) of weight factors.

In addition to MIMEFILT.EXE , 3D Graphic Tool includes MIMESORT.EXE, which minimizes the size of
differential data. It reduces the size of difference data, and assures efficient MIMe animation. For details, see
MIMESORT.EXE in the PlayStation Data Conversion Utilities manual.

The extended graphics library (libgs) is a 2- and 3-dimensional graphics system structured on the basic
graphics library (libgpu) and the basic geometry library (libgte). libgs processes data by object units (a group
of polygons), in contrast with the libgpu and libgte libraries which process polygon-level data. As the result
of introducing fixed paradigms, freedom and processing speed are slightly reduced compared to libgpu and
libgte. However, development efficiency improves dramatically.

For example, 3-dimensional program prototyping can be very simply executed with libgs. In addition, using
the abundance of attributes added to objects, it is possible to produce a variety of special effects very
simply.
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Outline

The Material Editor is a tool used to edit material for three-dimensional models.

The material means the following surface attributes that can be set for each polygon:

• Color
• Texture
• Transparency
• Shading method (Flat/smooth)
• Availability of light source calculation

NOTES:

The Material Editor does not support a function for creating texture.

Applying texture requires that the texture was created using a sprite editor, etc.

This manual covers Material Editor version 2.01. An older version should be replaced by the latest
one.

Operating Environment

As operating a three-dimensional model displayed on the video monitor, the user edits material. The artist
board is used to render a three-dimensional model. This requires that the artist board is installed in the host
computer.

The keyboard for the host computer is used to operate models. Materials are to be selected on Windows.

Fundamental Use

The following gives the basic method of operating the Material Editor.

1. Start up the Material Editor.
2. Select Open in the File menu. The dialog box used to select a file is displayed.
3. Select the file to be read in, and click the OK button. With the texture model set, the Texture

Arrangement dialog boxes corresponding to the number of textures used are displayed. Enter an
appropriate value into the dialog box.

4. If needed, operate the three-dimensional model displayed on the video monitor for movement to the
desired location and direction. The keyboard and the Spin button on the Moving dialog box can be
used to move the model.

5. Select the Material dialog box for the material menu.
6. Click the Polygon Selection button. The pointer is moved onto the video monitor, with the model for

polygon selection set up.
7. Select the polygon for setting the material.
8. Click the right button on the mouse to return the pointer to Windows.
9. Click the Radio button in the dialog box to set the material.
10. Repeat steps 6-9 to set materials for desired polygons.
11. Select Storage or Storage Under Another Name to save the file.



8-4 Reference: Material Editor

3D Graphics Tools

File Format

RSD Format

The Material Editor loads/saves 3D model data described in the RSD format. The RSD format is the
standard format for the PlayStation 3D graphics tool group, allowing the description of 3D model shapes
and materials. The RSD format is such that four kinds of files are used to describe a model. Specifications
of the RSD format are covered in the appendix of this manual.

Table 8-1: RSD File

File type Description

RSD file Describes relationships between the PLY/MAT/GRP file and the texture file.
PLY file Describes the shape of a model.
MAT file Describes material information of a polygon.
GRP file Describes grouping information of a polygon.

The use of the Material Editor requires that the RSD file have been created. The 3D graphics tool includes a
converter for converting the DXF format (format, for describing 3D shapes, supported by many
commercially available modelers) into the RSD format. Thus, the DXF file created by a commercially
available modeler can be used for 3D model data. For details, see Chapter 2, Creating 3D Model Data
(Tutorial).

trueSpace for PlayStation (DTL-S280), supplied by Caligari Inc., supports the RSD format. Thus, the RSD
file can be handled directly.

TIM Format

The Material Editor uses 2D image data described in the TIM format for texture mapping. The TIM format
can be created/edited by our sprite editor. Converters for the BMP, PICT and RGB formats are included in
the 3D graphics tool.

Directory Structure

RSD and TIM data to be used by the Material Editor must be stored into the directory in accordance with
the following rules.

• Only a file name must be described for PLY/MAT/GRP in the *.RSD  file. No absolute path can be
used.
Correct example 1

@RSD940102
PLY=HELI.PLY
MAT=HELI.MAT
GRP=HELI.GRP

Correct example 2
@RSD940102
PLY=HELI01.PLY
MAT=HELI02.MAT
GRP=HELI03.GRP

* File names for RSD/PLY/MAT/GRP can be different.

Incorrect example
@RSD940102
PLY=C:\TEST01\RSD\HELI.PLY
MAT=C:\TEST01\RSD\HELI.MAT
GRP=C:\TEST01\RSD\HELI.GRP
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* The absolute path is invalid.

• The PLY/MAT/GRP files referenced in the *.RSD  file must exist in the same path and their directory
name must be RSD.

Correct example
D:\GAME1\TEST1\HELI01.RSD (See HELI01.PLY, HELI01.MAT, HELI01.MAT.)
D:\GAME1\TEST1\RSD\HELI01.PLY
D:\GAME1\TEST1\RASD\HELKI01.MAT
D:\GAME1\TEST1\RSD\HELI01.GRP

Incorrect example 1
D:\GAME1\TEST1\HELI01.RSD (See HELI01.PLY, HELI01.MAT, HELI01.MAT.)
D:\GAME1\TEST1\HELI01.PLY
D:\GAME1\TEST1\HELI01.MAT
D:\GAME1\TEST1\HELI01.GRP

* The parent directory name is not RSD.

Incorrect example 2
D:\GAME1\TEST1\RSD\HELI01.RSD
D:\GAME1\TEST1\RSD\HELI01.MAT
D:\GAME1\TEST1\RSD\HELI01.GRP

* No PLY file exists.

• The texture file must be associated brotherly with the RSD data storage directory having a name of TIM.

Correct example
D:\GAME1\TEST1\RSD\HELI01.RSD (See BODY1.TIM, BODY2.TIM.)

…
D:\GAME1\TEST1\TIM\BODY1.TIM
D:\GAME1\TEST1\TIM\BODY2.TIM

Incorrect example
D:\GAME1\TEST1\RSD\HELI01.RSD (See BODY1.TIM, BODY2.TIM.)

…
D:\GAME1\TEST1\RSD\BODT1.TIM
D:\GAME1\TEST1\RSD\BODT2.TIM

* The TIM file does not exist in the TIM directory associated brotherly with the RSD directory.

Following the above three rules, store the RSD and TIM file groups in advance. Creating a directory for each
game tile and scene to store related RSD and TIM data under the directory will allow data to be processed
readily.

Example

C:\GAME01\SCN00\RSD
C:\GAME01\SCN00\TIM
C:\GAME01\SCN01\RSD
C:\GAME01\SCN01\TIM
C:\GAME02\SCN00\RSD
C:\GAME02\SCN00\TIM

…

Location of Texture Data on VRAM

Texture mapping under the PlayStation architecture requires that texture data be located on the VRAM.

How various image data should be located on the limited-size VRAM affects the design of a whole game
program. Thus, in the initial phase of authoring, it is difficult to completely fix texture location,

The RSD format provides only for the use of a TIM file as texture data. (VRAM address information is not
covered in the RSD file.) The address is always relocatable. Modifying the VRAM address of applied texture
never affects RSD data. For locating texture data, see Chapter 3, Creation of Texture Data (Tutorial).
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Ports and Addresses on Artist Board

The Material Editor uses a value written in the following file as the port address of the artist board.

C:\WINDOWS\ABOARD.INI

For example, if

addr=0x1340

is written in this file, the Material Editor uses a port address of 0x1340 to communicate with the artist board.
If the port address of an actual board is not set at 0x1340 by the dip switch, the Material Editor cannot
communicate correctly with the artist board.

If not set at 0x1340, use the ABOARD.EXE tool to modify file ABOARD.INI , or change the address of the
board to set up the same address value.

For the ABOARD.EXE tool, see ABOARD.EXE on page 10-3. For changing the port address of the artist
board, refer to the manual for the artist board.

File Menu

Open

Reads in a new 3D model.

Operation

1. Select Open.
2. Select the RSD file to be invoked in the displayed dialog box, and click the OK button.

On the Material Editor, the model is adjusted automatically for an appropriate size for easy operation.

With a texture applied on the invoked 3D model, the dialog box for setting the address of texture data is
displayed. (Thus, data can be located on the VRAM.)

Dialog Box for Texture Location

Figure 8-1: Dialog Box for Texture Location
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• Texture (X, Y)

Enter X and Y coordinates on the VRAM where image data is to be located. The initial value is X and Y
coordinates of the image section set in the TIM file.

• CLUT (X, Y)

Enter X and Y coordinates on the VRAM where the pallet is to be located. The initial value is X and Y
coordinates of the pallet section set in the TIM file.

• File

Name of the invoked TIM file

• Size

Lateral and longitudinal pixel sizes of the image data section

• Mode

Indicates the number of colors.

• 4 bits: 16 colors

• 8 bits: 256 colors

• 16 bits: 32768 colors

• OK button

Loads a texture to the VRAM address specified in the dialog box for texture location.

• Cancel button

Cancels the loaded texture. Loaded RSD data is also canceled.

As the VRAM address of texture data is relocatable, the set value is merely a tentative address.

The Material Editor uses the top left area of the VRAM for rendering and display. Locating texture data on
the area for rendering and display results in the destruction of the data.

The area for rendering and display depends on the screen resolution.

Table 8-2

  Screen resolution Area for rendering and display
Lateral x longitudinal       Top left-Bottom right

256 x 240 (0, 0)-(244, 479)
320 x 240 (0, 0)-(319, 479)
512 x 240 (0, 0)-(511, 479)
640 x 240 (0, 0)-(639, 479)

For resolution of 640 x 240, locating image data in the VRAM address (640, 0) causes no problem. But
locating image data in (639, 0) results in the destruction of one left edge line of image data.

For details about other texture locations, see Chapter 3, Creating Texture Data (Tutorial).

Reading in Vertex

With the RSD file read in, reads in only vertex information from another model to modify only the model
shape.

Operation

1. Select Reading in Vertex.
2. Select the PLY file to be invoked in the displayed dialog box, and click the OK button.

Application

If there are two or more models arranged so as not to damage the number of vertices and the status of
connection, material is set for only one of the models.
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Reading in vertices from the other models to be saved under other names allows the application of the
same material to more than one derivative model. The requirement is that the material be set only once.

Saving

Overwrites opened RSD data.

Saving Under Another Name

Saves currently opened RSD data under another name. An existing file with the name is overwritten. If there
is no file with the name, a new file is created.

Operation

1. Select Saving Under Another Name.
2. Enter a file name in the dialog box, and click the OK button.

NOTES: Saving texture-mapped RSD data into another RSD directory makes it impossible to look into the
TIM file. Therefore, copy the TIM file referenced into to the TIM directory.

TIM Reload

Reloads the VRAM with all the TIM files currently used as textures for the loaded model. Use this function if
another tool that uses the artist board has destroyed texture data on the VRAM.

Snap Shot

Saves the image currently displayed on the video monitor into a file in the TIM format. The image file can be
edited by the sprite editor for use as texture. This function enables texture data to be created.

Operation

1. Select Snap Shot.
2. Enter a TIM file name in the dialog box.

End

Terminates the Material Editor.

Material Menu

The material dialog box pops up. The dialog box is used to set all materials.
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Figure 8-2: Material Setting Dialog Box

RSD file: Name of file serving model being edited

Number of polygons: Total number of polygons in the model being edited

Polygon ID: ID of the last selected polygon

Operation

Select a polygon and use the radio button in the material dialog box to specify attributes of the polygon.

Shading

Sets a polygon shading method.

Flat : Flat shading. Clears a polygon boundary.

Smooth : Smooth shading. Smoothes a polygon boundary.

In the following figure, the left model is subjected to flat shading, while the left model is subjected to smooth
shading.

Figure 8-3: Shading effects

NOTES: Smooth shading is applied more effectively to polygons that are adjacent to each other with a
larger angle. To the contrary, a smaller angle results in a darker edge. See the left model in the
figure below.
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Figure 8-4: Angles between Polygons and Smooth Shading

Semi-transparency

Sets the degrees of semi-transparency for a polygon.

Semi-transparent: Makes a polygon semi-transparent.

Opaque: Makes a polygon opaque.

In the figure below, the left cube is displayed semi-transparently, while the right polygon is displayed
opaquely.

Figure 8-5: Semi-transparency

NOTES: Making a texture polygon (provided with applied texture) semi-transparent requires that the TIM
utility has been used to set the texture semi-transparency control (STP) bit at 1.

Texture Mapping

Sets the color or texture map of a polygon.

Texture Applies texture. The procedure of texture mapping is explained in detail in the next
section.

Color Applies color. The dialog box for setting color pops up. Select the color to be
applied. In the polygon selection mode, filling and brushing functions can be used.

Filling function Shift + Ctrl + right button click
Stores the polygon color as the current brush color.

Brushing function Shift + right button click
Applies the brush color to a polygon.
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Light Source Calculation

Specifies whether to carry out light source calculation.

On Carries out light source calculation.

Off Does not carry out light source calculation.

Light source calculation provides three-dimensional appearance. Without light source calculation, the same
color is applied to the whole polygon, providing no three-dimensional appearance.

Figure 8-6: Light Source Calculation

Application

With a partial model polygon colored brightly, no light source calculation is applied only the polygon.
Damping light for the model brightens only the part subjected to no light source calculation. The part
provides lighting effects.

Display

Specifies whether to display the selected polygon.

On Displays the polygon.

Off Does not display the polygon.

The display of a polygon is suppressed until Display is turned on. Further, such a polygon cannot be
selected by clicking the mouse.

Selecting a polygon whose display is suppressed requires the selection of all polygons by the F3 key or of a
cataloged group. Releasing display suppression allows the polygon to be displayed.

This function can be used validly to mask the polygons other than the target polygon when it is difficult to
select the target polygon because of the other obstacle polygons or when the target polygon is covered by
the other polygons.

Copy Button

Copies the selected polygon.

A newly created polygon shares the vertices with the old polygon. Both the polygons have the same normal
and material attributes. These values can be changed independent of one another.

The copying function is applicable to sealing and creating double-faced polygons.

• Sealing function

The surface of a plastic model can be sealed with texture.
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Applying texture with a transparent part onto the upper polygon combined with the lower polygon leads
to the observation of the lower polygon through the transparent texture part. The effective use of the
sealing function allows the significant reduction of the number of textures on the VRAM.

In the following example, two kinds of seals are applied onto the same-quality texture.

Figure 8-7: Sealing Function Example #1

The sealing function can bridge over difficulties of differently colored texture polygons. In the following
example, the left polygon is provided with typical texture, while the right polygon is provided with a seal.

Figure 8-8: Sealing Function Example #2

• Creation of double-faced polygon

Reversing a copied polygon enables the creation of a double-faced polygon. The following reversing
button is used to reverse a polygon.

In the following example, the right box provides the double-faced polygons corresponding to the
polygons in the left box.

Figure 8-9: Double-faced Polygon
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Reversing Button

Reverses the selected polygon.

This function is applied to reversed model data polygons and the creation of double-faced polygons (see
paragraph for the copying function).

Rendering Color Cataloging Button

The current rendering color is cataloged as the polygon material, with polygon light source calculation
turned off. For example, if a white polygon subjected to red light appears pink, the pink is cataloged as the
polygon color.

This function allows the three-dimensional appearance of the model, even though it is not subjected to light
source calculation on the program. The rendering color writing of a polygon through smooth shading after
the appropriate setting of the light source leads to the creation of a model with very effective gradation
color.

The material of a polygon where a rendering color has been written is changed as follows:

Table 8-3

Before writing After writing

Flat color Flat color
Smooth color Gradation color
Flat texture Color texture
Smooth texture Gradation texture

Rendering Color Clear Button

Resets the material to the status before writing the rendering color.

With a rendering color written, this function cannot be used.

Polygon Selection Button

Clicking this button sets up the polygon selection mode. You can leave the polygon selection mode by
clicking the right button.

The mouse cursor is displayed on the video monitor.

Smooth shading makes it difficult to select a polygon. In the polygon selection mode, however, all polygons
are rendered by flat shading.

To set up the previous shading method, leave the polygon selection mode and click the polygon selection
release button.

Mouse Operation in the Polygon Selection Mode

Move the mouse cursor inside the polygon to be selected and click the left button. The selected polygon
becomes red. Dragging the mouse enables the selection of two or more polygons. Clicking the selected
polygon and pressing the Ctrl key releases the selected polygon.

Pressing the F3 key causes all polygons to be selected. Pressing the F3 key again causes the selected
polygons to be released. (This also applies to other than the polygon selection mode.)

With polygons superimposed on one another, the polygons below are selected in order by successively
clicking the left button without moving the mouse cursor.

Table 8-4: Mouse Operation in the Polygon Selection Mode

Mouse/key operation Result
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Clicking the left button Polygon selection
Clicking the right button Termination of the polygon selection mode
Ctrl + clicking the right button Release of polygon selection
Shift + clicking the right button Brushing
Ctrl + Shift + clicking the right Filling button

Selected Polygon Release Button

Releases the selected polygons. The F3 key provides the same function.

Close Button

Closes the material dialog box.

Procedure for Texture Mapping

Texture can be mapped by parallel projection.

1. After selecting a polygon to be provided with texture, click the Texture radio button in the material
setting dialog box.

2. The File dialog box pops up. Select the TIM file for texture application.

3. The Texture Location dialog box pops up. Enter the texture image position on the VRAM, and the pallet
position.

4. The Texture Mapping dialog box pops up. The selected texture is displayed semi-transparently at the
top left on the video monitor.

Adjust the positions of the selected polygon and the texture by model movement, texture movement, or
texture extension or reduction.

The selected polygons that falls in the valid range of texture mapping are displayed in yellow. Checking
the valid range as moving the texture by pixel allows the texture and the polygon to be adjusted by
pixel.
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Texture Mapping Dialog Box

The dialog box is used for the parallel displacement, and the expansion and reduction of texture.

Figure 8-10: Dialog Box for Texture Mapping

←←←← ↓↓↓↓ and ↑↑↑↑ Buttons

These buttons are used for the parallel displacement of texture by pixel. Clicking the button with the Shift
key pressed causes texture to be moved by ten pixels.

Longitudinal Extension and Lateral Reduction Button

The button is used for the lateral extension and reduction of texture by pixel. Clicking the button with the
shift key pressed allows the extension or reduction of texture by 10 pixels.

These operations can also be carried out using the arrow keys on the keyboard.

← Left movement → Right movement
↑ Upper movement ↓ Lower movement
Ctrl-← Lateral reduction Ctrl-→ Lateral extension
Ctrl-↑ Lateral reduction Ctrl-↓  Longitudinal extension

Automatic Button

This button is used to automatically adjust the position and size of texture according to the selected
polygon.

Inversion Check Box

The check box allows mapping with texture inverted laterally.

Continuous Button

To apply the current texture onto another polygon, click this key instead of the OK key. The semi-
transparent target texture is left on the video monitor for continuous texture mapping.

OK Button

Clicking this button leads to texture application, followed by the closing of the texture mapping dialog box.
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Application

Multi-pallet Texture

Assigning one TIM image two or more different pallets enables the same images to be colored variously.
This means it allows images in TIM data to be shared. Thus, the VRAM can be used effectively. TIM can
describe more than one pallet (multi-pallet). However, the RSD format can only index the start address in
two or more pallets. Thus, each polygon cannot be assigned a pallet.

Possible actions are to create two or more TIM files with different pallet addresses from a TIM file for a multi-
pallet, and read in such TIM files through the Material Editor. The TIM data is stored in different files. As
image addresses and data contents are the same, however, the TIM data provides the same effects as a
multi-pallet on the VRAM.

The following example describes such actions.

1. Use the sprite editor to create a multi-pallet TIM file (FOO.TIM).
2. Us the TIMULTIL.EXE  pallet writing function to save pallets into different TIM files.

Example) Pallet Pallet address File
0 (480, 0) FOO0.TIM
1 (481, 0) FOO1.TIM
2 (482, 0) FOO2.TIM
…     …       …
N (480+N, 0) FOON.TIM

3. Read in FOO0.TIM.FOO1.TIM ,... as texture from the Material Editor.

Light Source Menu

The Light Source Setting dialog box pops up. Set a light source, an ambient color, and a background color.

Figure 8-11: Light Source Setting Dialog Box

Lighting Check Box

This check box allows the light source to be turned on and off.
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RGB

Sets the color of the light source.

Bearing and Elevation

Sets the direction of the light source.

Ambient

Sets an ambient color.

Background

Sets the color of the background.

Move Menu

The Visual Point/Model Movement dialog box pops up.

Set methods of model movement, visual point movement and rendering.

Figure 8-12: Visual Point/Model Movement Dialog Box
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Movement of Visual Point

Clicking the button allows the parallel displacement and rotation of the visual point. The model and the
visual point can also be moved by keyboard operation.

• Model rotation
A: Left S: CW distortion
D: Right C: CCW distortion
W: Upper
X: Lower

• Parallel displacement of visual point
Shift-A: Left Shift-S: Away from yourself
Shift-D: Right Shift-C: Toward yourself
Shift-W: Upper
Shift-X: Lower

• Model rotation (Units of 90 degrees)
Ctrl-A: Left Ctrl-S: CW distortion
Ctrl-D: Right Ctrl-C: CCW distortion
Ctrl-W: Upper
Ctrl-X: Lower

NOTES: Shortening the period until automatic repetition starts and the repetition interval on the keyboard
provides smooth model movement.

The keyboard command on the Windows control panel can be used for this setting.

Distance Between Visual Point and Screen

Sets the distance between the visual point and the screen. The picture angle is changed according to this
value.

Zoom

Extends the screen display without moving the visual point.

Rendering

Sets a method for rendering a model. The set rendering method is not reflected in material data.

• Wire frame

Displayed in a wire frame.

• Texture mask

Displayed with no texture applied.

• Light source calculation not carried out

Displayed with light source calculation not carried out.

• Default

Displayed according to the model material.

Vertex Edit Menu

The Vertex Edit dialog box pops up. The dialog box is used to move the vertices of a model. It can also be
used to specify a vertex color for gradation color polygon creation.
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Vertex ID

The ID of the selected vertex is displayed.

Vertex Selection Button

Clicking this button sets up the vertex edit mode, with the mouse cursor appearing on the video monitor.

Clicking the left button with the mouse cursor located near a vertex causes the vertex to be selected. The
selected vertex is displayed by a blue triangle.

To leave the vertex selection mode, click the right button

Mouse Operation in the Vertex Selection Mode

Drag and move a vertex by the mouse. Moving the mouse to the right causes the vertex to be moved along
the screen.

With the Ctrl key pressed, the vertex is moved only vertically.

With the Shift key pressed, the vertex is moved only horizontally.

With the Ctrl and Shift keys pressed, the vertex is moved only toward or away from yourself.

Application

The use of the vertex edit function along with the vertex read function enables the UV value to be adjusted
finely during texture mapping. The following example maps a square texture onto a trapezoid area.

1. Use the vertex edit function to make the trapezoid area rectangular.
2. Map the texture correctly in accordance with the rectangular area.
3. The model remains rectangular. Use the vertex read function to load the PLY file for the original model

to make the rectangular area trapezoid.

Now, the square texture is mapped correctly onto the trapezoid area.

Creating Gradation Color Polygon

Setting different colors for the vertices of a polygon allows the creation of a polygon with gradation color.

1. Select a polygon to be provided with gradation color.
2. Select vertices for which colors are to be set.
3. Use the color radio button in the material dialog box to select vertex colors.

Group Menu

The Group Management dialog box pops up. The dialog box allows a polygon group to be managed.

Only group selection enables the selection of all the polygons belonging to the group at a time. Thus,
materials can be edited rapidly.

Polygon Count

Number of polygons selected

Cataloging Button

Clicking this button causes the Group Name dialog box to be displayed. Clicking the OK button with a
group name specified in the dialog box allows the currently selected polygon to be cataloged as a group.



8-20 Reference: Material Editor

3D Graphics Tools

Group List

Lists the names of cataloged groups and the number of polygons.

Clicking a group allows the selection of all the polygons belonging to the group.

Delete Button

Deletes the selected group.

Automatic Creation Button

Automatically creates a group for each model material.

Rename Button

Renames the selected group.

OT Menu

The Ordering Table dialog box pops up.

The dialog box is used to set the bit length of the ordering table (1 to 14 bits).

Larger bit length provides high accuracy of polygon depth judgment, but the rendering speed is lowered.

Figure 8-13: odtlg.pict OT Dialog Box

Resolution Menu

Sets the resolution of the video monitor.

When setting screen resolution, take texture location on the VRAM fully into account. Replacing screen
resolution of 320 x 240 for the current texture location by resolution of 640 x 240 may result in the
destruction of part of the texture on the VRAM.

Figure 8-14: resoluti.pict Resolution Dialog Box
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Help Menu

Displays methods of binding keys, and operating the keyboard and the mouse.

Displays how to use the Help menu.

Displays version information and the version of the program currently used.



8-22 Reference: Material Editor

3D Graphics Tools



3D Graphics Tools

Chapter 9:
Animation Tool (ANIMATIO.EXE)
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Outline

Functions

This software is an authoring tool dedicated to motion design. It does not support modeling and rendering
functions. Checking an animation provided with textures requires hardware DTL-H2000, authoring tool TOD
View, or a programmer tool.

The Animation Tool supports the following functions:

• Layout of an object on a three-dimensional space

• Definition of the hierarchical structure of an object

• Creation of animation data

• Creation of information for use in data identification in the PlayStation unit

• Import of files

Startup of the command for converting a DXF file into the RSD file

• Export of files

• Output of animation data

• Startup of the command for converting an RSD file into TMD data.

• Startup of the output command of hierarchical data

File Configuration

This subsection outlines files handled by the tool.

Internal Files

This file is created and edited by the tool.

• PRJ file
Extension: .PRJ
File contents:
OBJECT.PRJ
Information used to identify an object in the PlayStation unit
MODEL.PRJ
Information used to identify TMD data in the PlayStation unit

• HRC file
Extension: .HRC
File contents:
Include hierarchical data for a PC, and information for defining relationships between objects laid out.
This file stores a list of sequence names cataloged by HRC.

• ACT file
Extension: .ACT
File contents:
Include sequence data for a PC (set of arranged key frame data), and information for use in defining the
position and direction of a created object.

• RSD file
Extension: .RSD
File contents:
Management of files storing information for defining model shapes and colors for a PC



9-4 Reference: Animation Tool

3D Graphics Tools

External Files

The external file storing model data to be converted into internal files and animation data to be passed to
the PlayStation unit cannot be handled directly by the tool.

• DXF file
Extension: .DXF
File contents:
Model data created by modelers of other firms. This data is converted by the Import command into the
corresponding RSD file to be used.

• TMD file
Extension: .TMD
File contents:
Model data for the PlayStation unit
The Export command is used for conversion from an RSD file.

• TOD file
Extension: .TOD
File contents:
Include hierarchical data or sequence data for the PlayStation unit converted by the Export command
from an HRX file and from sequence data on the memory.

Project

This tool first creates a project to uniquely manage an object. For example, a game tile is allocated as a
project. This prevents the duplicate occupation of the PlayStation memory by the same object in the game.

A project refers to a total item composed of the following directories and files, and does not refer to a
certain file.

A project is prohibited from looking into and including part of another project.

Figure 9-1

model.prj file
object.prj file
act directory

act files
cam directory
hrc directory

hrc files
lht directory
org directory
rsd directory

act files
tim directory
tmd directory

tmd files
tmp directory
tod directory

tod files

(project directory)

Required Environment

Operation and actual running require an environment which satisfies certain specifications.

The empty capacity of the needed RAM and HD depend significantly on the other applications running on
Windows, the network driver, and the set CONFIG.SYS, AUTOEXEC.BAT, and WIN.INI , as well as on the
data used, however. Thus, the tool may not be operated even though the following values are met.
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DOS/V: COP Intel486DX2  66 MHz

RAM: 16 MB

HD: 120 MB
Inner virtual memory: 35 MB

Video: 17 inches
256 colors available concurrently
Resolution: 1024 x 768 dots

OS: DOS version 5.0 or later versions
Microsoft Windows 3.1

Others: Mouse
Keyboard
Visual Basic Dynamic Link Library (DLL)

Menus/Commands

Project Menu

New Project

Creates a new project.

Operation

1. Select New Project.

The New Project dialog box is displayed.

2. Specify a drive and directory for project creation.

3. Enter the project name and click the Create button.

Figure 9-2: New Project Dialog Box

To move the displayed directory, double click it.

Open Project

Opens a project.

Cataloging a new file into or editing a cataloged file in the desired project requires that the project be
opened.
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Operation

1. Select Open Project.
2. Move the open project to the project directory.
3. Select the project and click the Open button.

NOTES: In the following figure, sample() is the project directory. Such project files as model.prj  and
object.prj  need not be selected.

Figure 9-3: Open Project Dialog Box

If the current directory is a project, the PRJ file is displayed and the Open button can be used.

Close Project

Closes a project.

Operation

Select Close Project.

NOTES: The dialog box for checking that the HRC file is saved is not displayed.

If this command has been issued with the new sequence opened, the dialog box for saving the sequence is
displayed. In that case, the HRC file as well as the ACT file is saved. This is because the sequence name is
cataloged into the HRC file and because the HRC and ACT files are adjusted for the added object and the
new hierarchical structure from the opening of the HRC file until the storage of the sequence. Note that the
position and attitude of an object written in the HRC file are also updated.

If the tool has detected the absence of the key frame during ACT file storage, the dialog box for requiring
the deletion of the ACT file is displayed.

New Sequence

Creates a new sequence.

The New Sequence dialog box is used to set a sequence name. Saving the HRC file leads to the cataloging
of its name. The name plus extension .ACT  is the name of the ACT file.

Operation

1. Select New Sequence. The New Sequence dialog box is displayed.
2. Enter a sequence name and click the Create button. The Keyframe Recorder is displayed.

The entered sequence name is displayed on the Keyframe Recorder title bar.

NOTES: The sequence names cataloged in the currently opened HRC file are displayed in gray characters
in the New Sequence dialog box. The name of the new sequence to be created must not be the
same as any of those names.
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This command requires that a sequence name be cataloged into the HRC file. Thus, it cannot be
executed if the HRC file has not been saved after the start of a job by the New command in the
File menu.

Open Sequence

Opens the ACT file

Operation

1. Select Open Sequence. The Open Sequence dialog box is displayed.
2. Select a sequence and click the Open button. The Keyframe Recorder is displayed.

The selected sequence name is displayed on the Keyframe Recorder title bar.

Close Sequence

Closes a sequence.

Operation

Select Close Sequence.

NOTES: The dialog box that asks whether to save an updated sequence is displayed. In that case, the
HRC file as well as the ACT file is saved. This is because the sequence name is cataloged into the
HRC file and because the HRC and ACT files are adjusted for the added object and the new
hierarchical structure from the opening of the HRC file until the storage of the sequence. Note that
the position and attitude of an object written in the HRC file are also updated.

If the tool has detected the absence of the key frame during ACT file storage, the dialog box for
requiring the deletion of the ACT file is displayed.

Save Sequence

Saves a sequence into the ACT file

Operation

Select Save Sequence.

NOTES: The HRC file as well as the ACT file is saved. This is because the sequence name is cataloged
into the HRC file and because the HRC and ACT files are adjusted for the added object and the
new hierarchical structure from the opening of the HRC file until the storage of the sequence.
Note that the position and attitude of an object written in the HRC file are also updated.

If the tool has detected the absence of the key frame during ACT file storage, the dialog box for
requiring the deletion of the ACT file is displayed.

File Menu

New

Creates a new HRC file.

Operation

Select New. The General window is displayed. Normally, the window covers coordinate axes of X (red), Y
(green) and Z (blue) for an applicable three-dimensional space (word coordinate system).

NOTES: Strictly speaking, no HRC file is created if the following commands are not executed:

• Save command
• Save As command
• Save Sequence command (including an answer of saving in response to the dialog box for 

saving the new sequence)
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Open

Opens the HRC file. Used to invoke and modify the saved HRC file.

Operation

1. Select Open. The Open dialog box is displayed.
2. Select the file and click the Open button.

Add Object

Adds a model to the applicable three-dimensional space.

When including a model into the applicable three-dimensional space, first select the RSD file of the model to
be added. Then, name the model. (This tool identifies an object by the name. The set name allows object
selection.)

The loaded model is a member of the applicable three-dimensional space (world coordinate system). For
the hierarchical structure, see Link Tool on page 9-28.

Operation

1. Select Add Object. The Add Object dialog box is displayed. (see the left part of the figure below)
2. Select the RSD file (model) to be loaded in Source List Box. Now, the Add button can be used.
3. Click the Add button. The selected RSD file is displayed in Add List Box.
4. Click the Done button to determine the file to be loaded. The Name Table dialog box is displayed. (see

the right part of the figure below)
5. Enter an object name into the Object Name column.
6. Click the Set button to load the file. The added model is displayed in the wire frame.

Figure 9-4: Add Object and Name Table Dialog Boxes

Add Object Dialog Box

• Add button

Displays a file name selected from Source List Box in Add List Box under the dialog box.
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NOTES: Double clicking the file to be selected in Source List Box makes it unnecessary to operate the
Add button.

• Remove button

Cancels the file selected in Add List Box. Select the file to be canceled and click the Remove button.

• Done button

Fixes the selected file. Clicking this button causes the Name Table dialog box to be displayed.

Name Table Dialog Box

• File Name box

The selected file name is displayed.

• Object Name box

The object name of the selected file is typed. The selected files must be assigned different object
names.

Two or more files cannot be assigned the same object name.

• Set button

Catalogs the RSD file name into the Model.PTJ  file and the object name into the OBJECT.PRJ file.

IMPORTANT: Each object name is unique. Even though the cataloged object has been deleted from the
HRC file, its name is saved permanently.

The object name can be entered in either uppercase or lowercase characters. Box, BOX
and box are considered to be the same object name.

The reserved words include the object names of default cameras.

• IsometricCamera
• TopCamera
• FrontCamera
• LeftSideCamera

Close

Closes the HRC file.

Operation

Select Close.

NOTES: The dialog box for checking that the HRC file is saved is not displayed.

If this command has been issued with the new sequence opened, the dialog box for asking
whether to save the sequence in the ACT file is displayed. The HRC file as well as the ACT file is
saved. This is because the sequence name is cataloged into the HRC file and because the HRC
and ACT files are adjusted for the added object and the new hierarchical structure from the
opening of the HRC file until the storage of the sequence. Note that the position and attitude of
an object written in the HRC file are also updated.

If the tool has detected the absence of the key frame during ACT file storage, the dialog box for
requiring the deletion of the ACT file is displayed.

Save

Saves the HRC file.

Operation

Select Save.

Save As

The new HRC file created by New or the currently opened HRC file is saved under an alias.
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Operation

1. Select Save As. The Save As dialog box is displayed.
2. Enter a file name and click the Save button.

Get Info

Displays details about the selected object.

Operation

Select an object and, then, Get Info. The Get Info dialog box is displayed.

Figure 9-5: Get Information Dialog Box

• Object Name

Displays the object name specified by the following commands.

• Model: Add Object command

• Camera: Create Camera command

• Origin: Create Origin command

• Object Type

Displays the type of an object (model/camera/origin).

• Resident

Displays the RSD file path for a selected object model. For a camera/origin, "Declared in HRC file" is
displayed as shown above.

• Original

This flag is not used currently.

• Parent Object

Displays a parent object name. (For parenthood, see Link Tool on page 9-28.)

• Number of Children

Displays the number of set member objects.

• Children list box

Displays a member object name.

• Number of Polygons

Displays the number of polygons constituting a selected object model.

• Number of Edges

Displays the number of edges constituting a selected object mode. This value is an estimated value.

• Number of Vertices

Displays the number of vertices constituting a selected object model.



Reference: Animation Tool 9-11

3D Graphics Tools

Import

Converts a DXF file into the corresponding RSD file.

This tool can convert the model developed by commercially available CG software into the RSD file by
starting up DXF2RSD.EXE. However, this requires that the model is saved by the software as a DXF file
that is supported by DXF2RSD.EXE supplied by our firm.

The RSD file created through the conversion is stored into the RSD directory of the object opened during
the startup of the conversion.

IMPORTANT: The use of this command involves the installation of the DXF2RSD.EXE file in directory
$PSXGRAPH$BIN for drive C:.

This command is not operated if the file is not installed in a different directory.

NOTES: This command can be used after the directory of an opened project for storing the results of
conversion has been fixed. Therefore, it can be used even with the HRD file opened. But the
created RSD file is not included in the HRC file. Including the created RSD file in a certain HRC file
calls for using the Add Object command.

Remarks

The use of DXF2RSD.EXE on the DOS or of its Windows version, DXF2RSDW.EXE, allows finer setting for
conversion.

Operation

1. Select Import. The Import dialog box is displayed.
2. Target the drive and directory storing the DXF, and select a file to be converted.
3. Enter a file name to be used after conversion.
4. Set parameters.
5. Click the Import button.

NOTES: Upon the start of the processing, the black DOS screen is set up. Following the DOS screen,
however, the Windows screen pops up.

The RSD file is not converted. The existing RSD file to be used is to be copied into the RSD
directory using the file manager.

Figure 9-6: Import Dialog Box

• Coordinate System list:

Specifies a method for the transformation of the DXF coordinate system. Specifies the upper coordinate
axis and its direction, as viewed from the front. For example, -Y+Z indicates that the Y axis is negative
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toward yourself and the Z axis is positive toward the top. The coordinate system for DXF does not
always coincide with the modeler screen. A test should be carried out to see if the appropriate software
name is displayed.

• File Type

Specifies a file type to be displayed in a file list.

• All: Displays all files on the current directory.

• DXF: Displays only the files having an extension of .DXF .

• 3D Face Only check box

Ignores POLYLINE and converts only 3DFACE.

• Smooth check box

Carries out smooth shading.

• Quad check box

Does not divide quadrangular 3DFACE into triangles. This allows reduction in the number of polygons
for a whole model.

• Scale box

Used to extend a model to be converted.

• Normal Vector radio button group

• None: Does not carry out the following processing.

• Back: Reverses the directions of the normals for all polygons.

• Both: Creates all polygons as double-faced polygons.

• Duplicate: Creates the obverses and reverses of all polygons independent of one another.

• Import button

Uses the set parameter to start up DXF2RSD.EXE.

• Import As text box

Enters the name of a file created by conversion. The new RSD file is saved into the RSD directory of the
currently opened project.

Supplementary Information: Model Data Conversion

The following example shows the process of converting a DXF file, displaying the model and saving the
HRC file.

1. Start up the software.
2. Select the New Project command in the Project menu to create a project.
3. Select the Import command in the File menu for conversion.
4. Select the New command in the File menu to create a space for application.
5. Select the Add Object command in the File menu to add the created RSD file to the application space.
6. Select the Save As command in the File menu to save the HRC file.

The following gives actions to be taken when no model is displayed.

First, repeatedly press the space key to near the origin of the application space. If a black point appears as
nearing the origin, this indicates that the model is too small for the PlayStation unit. Carry out conversion
again. Be sure to specify a larger value in the Scale column in the dialog box.

If none appear although the origin is neared, refer to the manual for DXF2RSD.EXE to check the CG
software. Even though the software is applicable, the model may not be displayed because of:

• Parameters for creating the DXF file
• A DXF release version
• Parameters for conversion.
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Export TOD

Creates a TOD file.

A TOD file can be created by converting only hierarchical structure or both hierarchical structure and
sequence. If the moving pattern is strong as in RCUBE in a demo for the programmer or if such items as
BALLS having no pattern are required, only hierarchical structure is converted as the object must be moved
by a program. Using the sequence created by this tool to generate an animation involves the conversion of
both hierarchical structure and sequence.

IMPORTANT: Using this command to convert only hierarchical structure requires that the MKTOD.EXE file
be installed in directory \PSXGRAPH\BIN for drive C:. If the file is installed in a different
directory, this command is not executed.

Operation

Conversion of only hierarchical structure:

1. Select an object to be converted. This selection is not required when all objects are converted.
2. Select Export, and TOD in the cascade menu. As shown below, the Export TOD dialog box is

displayed.
3. If the operation in step q has been carried out in the Export Object column, you can choose Selected. If

not, or when converting all objects, select All.
4. In the File Type column, select Structure.
5. Enter a file name to be used after the conversion, and click the Export button.

Conversion of both hierarchical structure and sequence:

1. Select an object to be converted. This selection is not required when all objects are converted.
2. Select Export, and TOD in the cascade menu. As shown below, the Export TOD dialog is displayed.
3. If operation in step q has been carried out in the Export Object column, you can choose Selected. If

not, or when all objects are converted, select ALL.
4. In the File Type column, select Animation. The Export TOD dialog is extended and displayed as shown

below.
5. Set parameters for an animation.
6. Enter a file name to be used after the conversion, and click the Export button.
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Figure 9-7: Export TOD Dialog Box

• Export Object

Specifies an object to be converted.

• All

Converts all objects depending on the file type.

• Selected

Converts only the selected objects. With no object selected, this button cannot be selected.

• File Type

Specifies the type of a file to be converted.

• Structure

Converts only hierarchical structure into the TOD file. The currently opened HRC saved last is
converted into the TOD file. Information not saved is not converted. Clicking this button inverts the
status.

• Animation

Converts both hierarchical structure and sequence into the TOD file. Data on the memory is
converted into the TOD file. The data includes the currently opened HRC file, the ACT file, and
operation results not saved. However, the objects for which no significant key frame is created, and
the default camera are not converted. Clicking this button inverts the status.

• Export button:

Starts conversion.

The following explanation is applicable only with Animation specified for File Type.

• Start[Frame]:

Specifies the start frame of the created sequence to be saved. The PlayStation unit fetches objects
from the CD-ROM into the memory to reproduce animations. The objects which have been fetched into
the memory need not be fetched again into the memory. Sequence reproduction calls for specifying
whether the object to be converted have been fetched into the memory.
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Create: Converts the object to be fetched first into the memory.

• Remarks

Create object control packets are developed for all the frames specified by Start. Given below is a
description of the color of the key frame marker with the key frame set in the frame.

Green: Create object control packet
Red: Create object control packet
Yellow: Create object control packet
Not set: Create object control packet

Exists: The object already fetched into the memory is converted.

• Remarks

Given below is a description of the color of the key frame marker with the key frame set in the
frame specified by Start.

Green: Create object control packet
Red: Kill object control packet
Yellow: No packet
Not set: No packet

• End[Frame]:

Specifies the end frame of the created sequence to be saved.

• Offset[Frame]:

Specifies the frame at which operation is to be started after the sequence has been invoked.

• Frame Rate[Sec/Frame]:

Specifies the period for the reproduction of one frame.

• Export As text box:

Specifies a file name to be used after the conversion.

Supplementary Information: Conversion of Hierarchical Structure (File Type = Structure)

The HRC file on the hard disk is processed by this command.

With the New command in the File menu used to create a new HRC file, no HRC file is created in the hard
disk. The file must be saved immediately before this command is executed.

Further, if the Open command in the File menu has been used to open the HRC file to be edited, the file
must be saved immediately before this command is executed. If the file has not been saved, the results of
editing are not reflected in the HRC file.

Upon the start of the processing, the black MS-DOS screen set up. Upon the end of the processing,
however, the Windows screen is set up.

Supplementary Information: Conversion of Hierarchical Structure and Sequence (File Type=Animation)

The sequence can be converted after the New Sequence or Open Sequence command in the Project
menu has been executed until the execution of Close Sequence.

Export TMD

Creates a TMD file.

IMPORTANT: The use of this command involves the installation of the RSDLINK.EXE file in directory
\PSXGRAPH\BIN for drive C:.

If the file is installed in a different directory, this command cannot be executed.

Operation

1. Select a model to be converted. This selection is not required when all the models contained in the
HRC file are converted.

2. Select Export, and TMD in the cascade menu. The Export TMD dialog box is displayed.
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3. If the operation in step 1 has been carried out in the Export Model column, you can choose Selected. If
not, or when all objects are converted, select All.

4. Enter a file name to be used after the conversion, click the Export button.

• Export Model

Specifies a model to be converted.

• All

Converts all models.

• Selected

Converts only the selected model. If no model has been selected, this button cannot be selected.

• File Type

Specifies the type of a file to be converted.

• All

Not used

• TMD

Converts a file into the TMD format. Information on the color and texture of model data is also
converted.

• Export button

Converts the selected model into the TMD format.

• Export As text box

Specifies a file name to be used after the conversion.

Supplementary Information: Model Data Conversion

Model data can be converted when the model is on the memory (i.e. after the New or Add Object
command in the File menu has been executed or when the HRC file has already been opened by the Open
command in the File menu).

Upon the start of the processing, the black MS-DOS screen is set up. Upon the end of the processing,
however, the Windows screen is set up.

After execution, a header file (with extension of .h ) containing a list of RSD ID numbers is created in the
Project directory. The header file is needed for the programmer.

Quit

Terminates the tool.

Operation

Select Quit. The tool is terminated.

NOTES: If this command has been issued with the updated sequence opened, the dialog box that asks
whether to save the ACT file is displayed. The HRC file as well as the ACT file is saved. This is
because the sequence name is cataloged into the HRC file and because the HRC and ACT files
are adjusted for the objects added after the HRC file has been opened until the sequence is
saved and for the updated hierarchical structure. Note that the position and attitude of the object
written in the HRC file are also updated.

If this tool has detected the absence of the key frame during the saving of the ACT file, the dialog
box for requiring the ACT file to be deleted is displayed.

Edit Menu

Undo/Redo

Undoes the last executed operation
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Operation

Immediately after the menu or the tool has been used, select Undo. The operation is canceled, with the
menu item changed to Redo. Selecting Redo leads to the setup of the previous status.

Supplementary Information: What can be Done by Undo

The following gives what can be done by Undo:

1. Parallel displacement, rotation, extension and reduction of an object
2. Hierarchical structure: Link and Unlink commands
3. Lock and Unlock commands
4. Cut, Copy and Paste command

NOTES: Undo by Ctrl-Z is valid only when the window has a focus. Clicking the tool packet moves the
focus to the tool palette. Thus, Undo by Ctrl-Z is unavailable. Unto under this status involves the
selection of Undo in the pull-down menu.

Note that focus movement by clocking a window may cause unexpected results (except for
selection by a title bar).

Operation in the key frame recorder is not covered by Undo. For example, with an object rotated
to catalog the key frame, the object is reset by Undo, but the key frame is not deleted.

Cut

Erases the selected object for inclusion in the clipboard. The selected object disappears from the screen.

Operation

Select the object to be included in the clipboard and, then, Cut.

Copy

Includes a copy of the selected object into the clip board The selected object is left on the screen.

Operation

Select the object to be included in the clipboard and, then, Copy.

Paste

Copies the object included in the clipboard. Copies the object included by Cut or Copy into the clipboard.

Operation

• Select Paste. The Name Table dialog box is displayed.
• Enter an object name into the New Object Name box and click the Set button.

Remarks: Name Table Dialog Box

The name of the last pasted object is displayed in the Old Object Name column in the dialog box.

Supplementary Information: Cut, Copy, Paste

Objects and their member sub-objects are covered by Cut, Copy and Paste. Copying the selected shoulder
object leads to the duplication of the shoulder and the arm. Before a hierarchy is created or by temporary
Unlink, only the shoulder object can be copied.

Cut and Copy duplicates parameters for the rotation, extension and parallel displacement of the original
object. The Paste command is used to duplicate the object in the same attitude, size and position.

For hierarchical structure, however, the parent information of the original object (selected for Cut or Copy) is
not duplicated. The pasted object belongs to the world coordinate system of the uppermost layer. Naturally,
the hierarchical structure below the pasted object is the same as of the original object.

The clipboard is located on the memory. Cutting or copying data over 30,000 polygons consumes a large
amount of memory and makes the operation unstable depending on the swap setting. In such a case, save
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the needed file and terminate the program. The memory benefits from loads reduced by the clipboard for
the subsequent startup.

The three-dimensional clipboard is particular to this tool. Data cannot be exchanged with other software via
the board.

Clear

Erases the selected object

Operation

Select the object to be erased and, then, Clear.

Preferences

Initialization (Updates plane size and position).

The position and roughness of a plane for use in movement evaluation can be set. The parameters set
below are default values.

Operation

Plane Min: Specifies the plane start position.

Plane Max: Specifies the plane end position.

Grid Pitch: Specifies plane roughness.

Figure 9-8: Preferences Dialog Box

View Menu

Magnify

Magnifies and displays window contents

Short Cut: Magnifier tool in the tool palette

Operation

Magnifies by a factor of two and displays window contents around the clicked position.

Minify

Minifies and displays window contents

Short Cut: Shift key plus Magnifier tool in the tool palette
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Operation

Minifies by a factor of two and displays window contents around the clicked position.

Supplementary Information: Magnify/Minify Command and Scroll/Magnifier Tool

These functions are not related to the camera. The result of operation never affects the position, direction
and focus of the camera. The functions are equivalent to dark room work for printing dislocation and size
changes. Therefore, the range beyond printing paper is not displayed. The range of printing paper is the
square, prepared on the basis of the longer side of the full-scale window, multiplied by display power.

Show Origin/Hide Origin

Displays/hides the origin

Operation

Select Origin. The origin is displayed, with the menu item replaced by Hide Origin. Selecting Hide Origin
hides the currently displayed origin.

IMPORTANT: The origin not put in the field of view is not displayed

The red, green and blue of the origin corresponds to the X, Y and Z axes, respectively.

Supplementary Information: Origin

The origin is used to update the center of model rotation for developing hierarchical structure and connect
the extended and reduced models so as to prevent its members from being affected.

The following gives differences between the origin and the model.

1. Coordinate system and origin

The coordinate system as a mathematical concept is not the origin. Thus, the local coordinate systems
for a model and a camera are not displayed.

2. The origin is not displayed under the typical status. Displaying the origin requires the selection of Show
Origin in the View menu.

NOTES: The origin can be displayed by the Create Origin or Move Origin Only command as well.

3. The origin must not be extended nor reduced.

The origin cannot be extended nor reduced directly by this tool to prevent effects of the past
hierarchical structure.

NOTES: The implemented hierarchical structure of the PlayStation unit is such that extension and
reduction is transmitted to descendants and cannot be canceled. Thus, during rotation, the
object may frequently incur shear deformation. The tutorial provides an example of using the
origin to bridge over these difficulties.

4. There is no file. There is no file equivalent to the RSD file for the model.

Show Camera/Hide Camera

Displays/hides the camera.

Operation

Select Show Camera. The camera is displayed, with the menu item replaced by Hide Camera. Selecting
Hide Camera hides the currently displayed camera.

IMPORTANT: The camera not put in the field of view is not displayed.

Supplementary Information: Camera

This tool supports four default cameras used to display the General[Isometric], Top, Front and Left Side
windows. But the cameras are not used for serving the PlayStation unit. Only the position and attitude
information of the developed camera object are passed to the PlayStation unit.
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NOTES: Among the default cameras, the Top, Front and Left Side cameras cannot be selected. An
attempt to select any of those cameras results in the generation of an alarm.

The following gives differences between the model and the camera.

1. The camera is not displayed under the typical status. Displaying the camera involves the selection of
Show Camera in the View menu.

NOTES: The camera can be displayed by the Create Camera or Move Camera Only command as well.

2. The camera must not be extended nor reduced. The object must not reflect effects of the extension
and reduction of the past hierarchical structure.

3. Children of hierarchical structure must not be created.

4. More operations means are supported.

• Keyboard

With a window selected, pressing the following keys changes the display:

Left Arrow: Facing left: 10 degrees
Right Arrow: Facing right: 10 degrees
Left Arrow + Shift: Tilting left: 10 degrees
Right Arrow + Shift: Tilting right: 10 degrees
Space: Advance: 1000
Space + Shift: Retreat: 1000

Left Arrow + Ctrl: Facing left: One degree
Right Arrow + Ctrl: Facing right: One degree
Left Arrow + Shift + Ctrl: Tilting left: One degree
Right Arrow + Shift + Ctrl: Tilting right: One degree
Space + Ctrl: Advance: 100
Space + Shift + Ctrl: Retreat: 100

NOTES: With the camera retreating in the Back Face Cull mode, the object put in the field of view is
chipped. This is because judgment on the attitude is omitted during camera movement by the
keyboard for more rapid re-rendering.

• See the Set View command.

5. There is no file equivalent to the model RSD file. No focus information is saved.

Show Backface/Hide Backface

Displays/hides the reverse of an object.

Operation

Select Show Backface. The reverse of an object is displayed, with the menu item replaced by Hide
Backface.

Selecting Hide Backface hides the reverse of the object. This mode is referred to as the Back Face Cull
mode.

Show Plane

Displays a plane on three-dimensional space.

Related command: Preferences in the Edit menu

Operation

Select Show Plane and, then, any of the XY, YZ and ZX planes in the cascade menu. The selected plane is
displayed.

Hiding the currently displayed plane involves the selection of Show Plane in the cascade menu.
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Set View

Sets the camera to be allocated to the General window. Used to operate or select the camera allocated to
the General window.

Operation

1. Select Set View.
2. First, select a camera in the Camera list.
3. When changing the purse, move the Focus scroll bus to the desired position.
4. To check the view, press the Preview button. The view from the camera selected on the screen is

displayed.
5. Click the Set button to select a camera.

NOTES: With no camera created, only IsometricCamera is displayed.

The Top, Front and LeftSide cameras are not covered.

If the camera allocated to the General window cannot be identified, check the title bar for the
General window.

With no camera created, no camera is selected.

Remarks

If it is troublesome to press the Preview button, press the Space key. Double clicking in the Camera list
enables both selection and inspection.

Figure 9-9: Set View Dialog Box

• Camera list:

A list of camera names (default IsometricCamera, and any camera names assigned to the cameras
created by Create Camera in the Tool menu) is displayed. The list is used to select camera to be
allocated to the General window.

• Focus:

Modifies the focus of the selected camera.

• Wide: Wide angle

• Telescope: Telescope

• Screen:

Clicking the Preview button displays the three-dimensional space as viewed from the selected camera.

• Preview button:

Used to check the view from the selected camera.
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• Set button:

Fixes allocation. The view from the selected camera is displayed in the General window.

• Option button:

Used to specify the view point, view target and twist angle (screen gradient) of the selected camera.
The set View dialog box as shown below is used to specify the values of parameters. In the View Point
and View Target columns, red indicates the X axis, green the Y axis, and blue the Z axis.

The bottom check box is used to advance and retreat the camera by the distance specified in the right
text box.

IMPORTANT: The specified value is based on the coordinate system defined by the parent object of the
selected camera. The position is an absolute value, while the angle and distance are relative
values.

Figure 9-10: Set View Dialog Box (With Option button pressed)

Tool Menu

Tool Palette

Displays/hides the tool palette.

Operation

• Display

Select the Tool Palette command in the menu. The left side on the command is checked.

• Hide

Reselect the Tool Palette command. The check mark disappears.

See Tool Palette on page 9-25.
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Keyframe Recorder

Hides/displays the key frame recorder.

Operation

• Hide

Select the Keyframe Recorder command in the menu. The left side on the command is checked.

• Display

Reselect the Keyframe Recorder command. The check mark disappears.

NOTES: This command is valid with the sequence opened (i.e. after the execution of the New Sequence
or Open Sequence command until the execution of the Close Sequence command). The key
frame recorder is displayed first by the New Sequence or Open Sequence command.

See Key Frame Recorder on page 9-30.

Object Browser

Uses a name to select the object.

Figure 9-11: Object Browser

Operation

1. Select the Object Browser command in the Tool menu. Object Browser is displayed. The buttons to the
left of the browser display the selected object (indicated in the red frame. Each window displays the
bounding box.), and its ancestors. The right list displays children of the selected object.

2. To select an object, select an object name from the right list, and press the Select button. (Or, double
click an object name in the right list.) To select an ancestor, click the left button. To release the
selection, click the World button.

3. To fix the selection, click the Done button and close the browser.

Create Origin

Creates a new origin.
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Operation

1. Select CreateOrigin. The Set Origin Name dialog box is displayed.
2. Enter the name of the origin into the dialog box and click the OK button. The origin is displayed in the

world coordinate system.

Create Camera

Creates a new camera.

Operation

1. Select Create Camera. The Set Camera Name dialog box is displayed.
2. Enter the name of a camera into the dialog box and click the OK button. The camera is displayed at the

origin of the world coordinate system.

Move Origin Only

Operates only the origin.

Short Cut: Origin Only tool in the tool palette

Only the origin can be operated, with the other objects protected against operation. Not displayed, the
origin is displayed.

Operation

Select Move Origin Only.

Move Camera Only

Protects the objects other than the camera against operation.

Short Cut: Camera tool in the tool palette

Only the camera can be operated, with the other objects protected against operation. Not displayed, the
camera is displayed.

Operation

Select Move Camera Only.

Link

Sets parenthood. Supports the same function as the Link tool in the tool palette. Select the Link command
instead of clicking the Link tool.

Unlink

Releases the set parenthood. Supports the same function as the Unlink tool in the tool palette. Select the
Unlink command instead of clicking the Unlink tool.

Window Menu

Cascade

Displays the window in a cascade.

Operation

Select Cascade.

Tile

Displays the window in a tile.
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Operation

Select Tile.

The Top window is located at the top left. The General window is located at the top right. The Front window
is located at the bottom left. The LeftSide window is located at the bottom right.

Arrange Icons

Arranges the displayed window icons.

Operation

Select Arrange Icons.

General

Displays the General window. The displayed General window is given as an icon.

Operation

Select General.

Top

Displays the Top window. The displayed Top window is given as an icon.

Operation

Select Top.

Front

Displays the Front window. The displayed Front window is given as an icon.

Operation

Select Front.

Left Side

Displays the Left Side window. The displayed Left Side window is given as an icon.

Operation

Select LeftSide.

Help Menu

About

Displays the version of the program currently used. Checks the DLL version needed for the tool. If the
version is not correct, the program is terminated.

Operation

Select About. The About dialog box is displayed. To close the dialog box, click the About dialog box.

Tool Palette

Left figure: Default mode.

Center figure: Mode where the axes operated by the mouse are restricted.

Right figure: Mode for selecting the coordinate system operated through value input.
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Figure 9-12: Tool Palette

                  

Mouse

Restricts the direction of parallel displacement by the mouse, or the axis of rotation. With axes restricted,
the coordinate system as the reference of operation can be selected in the System column in the tool
palette.

Operation (See the above center figure)

1. Select an object.

2. Select an axis to be operated in the Mouse column. The Local and Global radio buttons are displayed
in the System column in the tool palette.

• All axes: Not restricted.

• X only: Restricts the axis to be operated to the axis parallel to the X axis and passing through the
center of the bounding box.

• Y only: Restricts the axis to be operated to the axis parallel to the Y axis and passing through the
center of the bounding box.

• Z only: Restricts the axis to be operated to the axis parallel to the Z axis and passing through the
center of the bounding box.

3. Select the coordinate system as the reference of operation in the System column in the tool palette.

4. Operate the object.

NOTES: This function is not associated with model extension and reduction.

With any of X, Y and Z Only selected, move the mouse to the top left or right on the screen for
operation.

Numeric

Numeric input is used for operation. For numeric input, the coordinate system as the reference as operation
can be selected in the System column on the tool palette.

Operation (See the above right figure)

1. Select the tool for the intended operation from the tool palette.

• Parallel displacement: Translation tool

• Rotation: Rotation tool

• Extension/reduction: Scaling tool

2. Select an object.
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3. Enter parameters into the Numeric column. The Local and Global radio buttons are displayed in the
System column on the tool palette.

4. Select the coordinate system as the reference of operation in the System column on the tool palette.

5. Press the return key or click the OK button.

NOTES: This function invalidates the setting of the mouse.

The Tab key can be used for movement in the Numeric column.

System

Selects the coordinate system as the reference of operation

Local: Coordinate system where the center of the bounding box is the origin and the axes are
parallel to and in the same direction as the appropriate axes in the local coordinate system
for the camera, the origin and a model after conversion

Global: Coordinate system where the center of the bounding box is the origin and the axes are
parallel to and in the same direction as the appropriate axes in the World coordinate
system

NOTES: Only for parallel displacement, with All Axes (see the above left figure) selected in the Mouse
column on the tool palette, another coordinate system is set. In the coordinate system, the center
of the bounding box is the origin and the axes are parallel to and in the same direction as the
appropriate axes in the visual point coordinate system for the camera for the window.

Magnifier Tool

Magnifies and displays window contents.

Related commands: Magnify and Minify in the View menu

Magnifies or minifies by a factor of two, and displays a window.

Operation

• Magnification for display:
1. Click the Magnifier tool.
2. Click the center of magnification.

• Minification for display:
1. Click the Magnifier tool.
2. With the Shift key pressed, click the window to be minified.

NOTES: The window cannot be remodeled.

Scroll Tool

Makes the window scroll.

Operation

1. Click the Scroll tool.
2. Click the center of the window.

NOTES: The window cannot be remodeled.

Lock Tool

Locks parameters for the selected object.

Operation

1. Click the Lock tool.
2. Select an object to be locked. The locked object is displayed in the blue bounding box is protected

against changes in the position, attitude and hierarchical structure by direct operation.
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NOTES: With an object with an ancestor locked, the object is affected by operating the ancestor.
If the object having a created sequence has been locked, the sequence can be reproduced, but
cannot be edited.

Unlock Tool

Unlocks an object

Operation

1. Click the Unlock tool.
2. Select an object to be unlocked.

Link Tool

Creates hierarchical structure. A related command is Link in the Tool menu

With object A set as the parent and object B set as a child, object B can be moved by moving object A.
This is called linking. Parent selection leads to child selection. The parent and child objects can be moved
and rotated as a unit. Further, only the child can be selected for movement and rotation. One object can be
allocated more than one child.

Operation

1. Select an object to be set as the child.
2. Click the Link tool.
3. Select an object to be set as the parent. For the selected parent, the green bounding box is blinked.

(For the selected child, the red bounding box is blinked.) Setting another parent involves the selection of
an object different from the selected parent. Continuous linking requires that the empty window be
clicked to release the selected child. Then, repeat steps (1) to (3).

NOTES: A descendant can be selected as the parent.

Unlink Tool

Releases hierarchical structure.

Related command: Unlink in the Tool menu

Operation

1. Click the Unlink tool.
2. Select the object set as a child. The bounding box for the selected parent is blinked in green.

Model Only Tool

Operates only a model without moving the camera and the origin.

Operation

With this tool appearing in black on the white base as a result of clicking, only a model can be operated. To
release this mode, click this tool again.

Exception

The current camera can be operated by the keyboard and the camera can be operated by Option in the
Set View dialog box in this mode as well.

Origin Only Tool

Allows only the origin to be operated.

Related commands: Show Origin in the View menu and Move Origin Only in the Tool menu

Only the model can be operated without moving any models and camera.
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Operation

With this tool appearing in black on the white base as a result of clicking, only the origin can be operated.
To release this mode, click this tool again.

Exception

The current camera can be operated by the keyboard and the camera can be operated by Option in the
Set View dialog box in this mode as well.

Camera Only Tool

Allows only the camera to be operated.

Related commands: Show Camera in the View menu and MoveCameraOnly in the Tool menu

Only the camera can be operated without moving any models and camera.

Operation

With this tool appearing in black on the white base as a result of clicking, only the camera can be operated.
To release this mode, click this tool again.

Translation Tool

Allows only parallel displacement.

Related commands: Mouse, Numeric and System on the tool palette

Operation

1. Click Translation tool.
2. Select an object to be subjected to parallel displacement.
3. Select a plane of the bounding box and drag it to the desired position. When moving the plane in the

depth direction, drag it with the shift key pressed. Moving the mouse toward yourself causes the plane
to near yourself. Moving the mouse away from yourself causes the plane to leave yourself.

For Correct Parallel Displacement

1. Click Translation tool.

All items in the Numeric column on the tool palette are reset to 0.0.

2. Select an object to be subjected to parallel displacement.

3. Enter the amount of parallel displacement into the Numeric column on the tool palette.

4. Press the return key or click the OK button.

NOTES: Steps 1 and 2 can be reversed. This means that an object may have been selected.

Rotation Tool

Allows only rotation

Related commands: Mouse, Numeric and System on the tool palette

Operation

1. Click Rotation tool.
2. Select an object to be rotated.
3. Drag an edge or vertex in the bounding box for rotation to the desired position.

For correct Rotation

1. Click Rotation tool. All items in the Numeric column on the tool palette are reset to 0.0.
2. Select an object to be rotated.
3. Enter into Numeric Control the degree of rotation from the current attitude about the X, Y and Z axes in

the world coordinate system with respect to local coordinates. (Units = degrees)
4. Click the OK button.
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NOTES: Steps 1 and 2 can be reversed. This means that an object may have been selected.

Scaling Tool

Allows only extension or reduction.

Related commands: Mouse, Numeric and System on the tool palette

Operation

1. Click Scaling tool.
2. Select a model to be extended or reduced.
3. Select a vertex of the bounding box. Dragging the vertex away from the center of the bounding box

provides extension. Dragging the vertex toward the center provides reduction.

NOTES: Selecting and operating a vertex displayed near the center results in a rapid size change. The
following gives operation for accurate extension or reduction.

1. Click Scaling tool. All items in the Numeric column on the tool palette are reset to 1.0.

2. Select a model to be extended or reduced.

3. Enter into Numeric Control the power of extension or reduction along the X, Y and Z axes in 
the local coordinate system. (0 < power < 8)

4. Click the OK button.

Scaling tool is applicable only to the models. The tool must not be applied to the origin and the
camera.

Steps 1. and 2. can be reversed. This means that an object may have been selected.

Key Frame Recorder

Sequence creation requires that key frames be required as nodes of operation. Recording two or more key
frames leads to automatic linear interpolation between the key frames and to sequence creation.

Names and Functions of Components

Figure 9-13: Key Frame Recorder

Keyframe Marker

The key frame marker indicates the position of the key frame marker set for the selected object. The
following gives the meaning of colors.

Green: Signifies that the key frame contains an instruction for copying object data from
PlayStation's CD-ROM into the RAM.

Yellow: Signifies that the key frame contains no instruction. (The marker is created in the frame
following the green marker.)

Red: Signifies that the key frame contains an instruction for discarding an object from
PlayStation's RAM.

The current frame can be changed to the key frame by clicking the key frame marker.

The key frame can be updated by dragging the key frame marker.
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NOTES: The color of the key frame marker depends on the status of the Create and Kill buttons during
key frame recording. (See the following figure.)

With no object selected, the key frame marker is not displayed.

Create and Kill Buttons

These buttons are used to set the flag having meaning only during animation execution by the PlayStation
unit at the key frame.

Figure 9-14: Create and Kill Buttons

Create button: If the result of clicking this button is Creation (above left figure), the green key frame marker
is created. If the result is Intermediate (above center figure), the yellow key frame marker is
created.

Kill button: If the result on clicking this button is Killing (above right figure), the red key frame marker is
created. If the result is Intermediate (above center figure), the yellow key frame marker is
created.

NOTES: On the PC, the object displayed on the screen is not changed, even though Create or Kill has
been specified. For reproduction by the PlayStation unit, however, the object is created or
discarded by this information. Thus, the object before creation and after discarding is not
displayed on the TV set.

For the meaning of the color of the key frame marker, see paragraph for the key frame marker.

Slider

Indicates the current frame. Dragging the slider allows the current frame to be updated.

Graduation

Clicking the graduation at the current frame position enables the current frame to be updated.

Current Frame Text Box

Indicates the current frame. Pressing the return key with a numeric character entered in this column allows
the setup of this value as the current frame. The values not less than zero and not more than 720 can be
entered.

Current Frame Control Button

Sets the key frame for the selected object as the current frame.

First button: Start key frame

Previous button: Key frame preceding the current frame

Next button: Key frame following the current frame

Last button: Last key frame

NOTES: This button is valid, only when the selected object has the key frame.
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Animation Button

Play button: Plays animations from the current frame.

Reverse Play button: Plays animations in reverse from the current frame.

Stop button: Stops the animation.

NOTES: This button is valid, only when the selected object has more than one key frame.

Propagate Check Box

Specifies whether to propagate the setting or deletion of the key frame to the descendants of the object as
well.

Such setting and selection is propagated if the box has been checked.

Record Button

Sets the key frame of the selected object. Modifying the key frame requires resetting by this button.

NOTES: The Record button is valid, only when an object is selected.

Erase Button

Erases the created key frame. Click the marker of the key frame to be erased and, then, the Erase button.

NOTES: The Erase button is valid, only when an object is selected.

Setting Key Frame

Figure 9-15: Setting Key Frame
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Operation

1. Select an object whose key frame is to be set.
2. Select Keyframe Recorder. If the selected object is provided with the set key frame, the key frame

marker is displayed.
3. Move the slider to the frame where the key frame is to be set. On the screen, the object corresponding

to the frame is displayed.
4. Operate the object to determine its position and attitude. Before the key frame is set, this status is not

recorded.
5. Click one of the Create and Kill buttons.
6. Click the Record button and set the key frame. Carry out steps (3), (4), (2), (5) and (6) in that order if

needed. (If yellow has been set up, step (5) can be omitted.)

NOTES: No key frame is set if the Record button is not pressed. Carrying out any of the following
operations after step 4 results in the loss of object location results without being recorded.

• The current frame is changed (except for dragging the slider as pressing the Ctrl key).
• An object different from the currently selected object is selected.

Key Frame Correction 1: Modification of Object, Position, and Attitude, or Create or Kill

Operation

1. Select an object.
2. Select Keyframe Recorder.
3. Click the key frame marker to search for the key frame to be corrected.
4. Operate the object to update the position and attitude, and change the Create and/or Kill buttons.
5. Click the Record button.

Key Frame Correction 2: Copying of Object, Position, and Attitude

Operation

1. Select an object.
2. Select Keyframe Recorder.
3. To provide for copying, drag the slider to update the current frame.
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4. With the Ctrl key pressed, drag the slider to the frame to be copied. The slider is changed as shown
above.

5. Click the Record button. The slider display is returned to the previous status.

NOTES: The above displayed slider indicates that the status currently displayed in the window may not
reflect interpolations on the frame.

Key Frame Correction 3: Movement of Key Frame Marker

This method allows the modification of acceleration in the same order of key frames. Further, the key frame
order can be changed.

Operation

1. Select an object.
2. Select Keyframe Recorder.
3. With the Ctrl key pressed, drag the key frame marker.

IMPORTANT: Upon the selection of the key frame marker, the mouse cursor points to the sand clock.
After the cursor has been returned to the original state, start to drag the key frame marker.

Polygon Indicator

Figure 9-16: Polygon Indicator

Indicates the total number of polygons in a model. The above figure indicates about 1400 polygons.

Yellow zone: 3,000 or more polygons:
Beyond the value recommended for the PlayStation unit.

Red zone: 5,400 or more polygons:
Old version left to provide for polygons in addition to the yellow zone

NOTES: Polygons for the camera and origin are not covered, as they are not passed to the PlayStation
unit.

Limitations

1. Displaying the keyframe recorder involves screen resolution of 1024 x 768 dots or more.

2. Screen color customization is not supported. Some setting makes buttons, switches and icons
invisible. On the basis of the comparison of the actual display with settings in this manual, the standard
Windows settings should be introduced.

3. Any windows should be clicked only if required. Events of re-rendering are accumulated in the queue,
and it takes more time to carry out the subsequent operation. Excessive clicking repetition results in an
overflow of the event buffer, with an alarm produced. Ignoring the alarm results in system down.

4. The maximum number of polygons that can be loaded is about 20 times more than the recommended
value (3,000 polygons) for the PlayStation unit. This value depends on the currently operated
application and data.

5. The Scroll and Magnify/Minify commands are inapplicable to a remodeled window. Remodeling requires
that this tool be turned off. The tool active during animation reproduction may result in screen trouble.

6. The setup of the previous screen with a window covered by other windows and dialog boxes may leave
the displayed picture chipped, but the program and data are not affected. Carry out the following
operation.

To re-render all four screens, press the F5 key. To re-render a certain screen, click the screen free of
any objects.

7. To re-render only the moved object, the object position becomes white.
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The program and data are not affected. If more positions have become white, carry out the operation in
item 6 to re-render the screen.

8. Upon the following operation, a ghost of the bounding box appears. But the program and data are not
affected. To remove the ghost, carry out the operation in step 6 for re-rendering.

Undoing, screen remodeling, or key frame setting in the order of object operation and slider operation

9. Before closing, the dialog box for specifying whether to save the HRC file does not pop up.
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ABOARD.EXE

Overview

ABOARD.EXE is an application for Windows for setting an I/O address to access the artist board (DHL-
H201A). The I/O address set by this tool is looked into by the programs which use the artist board including
the Material Editor, the sprite editor, the TIM utility, and the plug-in module for PhotoShop.

Operation

Upon the startup of ABOARD.EXE from the file manager, the following window pops up.

Figure 10-1: ABOARD.EXE Main Window

Upon the first startup of ABOARD.EXE, 0 x 1340 is displayed as the address. This is the factory set default
for the artist board. If the I/O address has been changed by the dip switch on the board, use this
application to modify the address setting.

An address can be set for each of the upper six bits and lower ten bits.

Saving the set value calls for pressing the OK button. Canceling the set value requires that Cancel be
pressed. Close in the window menu is equivalent to Cancel. Pressing OK causes the set I/O address to be
saved into /WINDOWS/ABOARD.INI .

Remarks

According to Address Setting in the instruction manual for the artist board, 0 x 134 is set in the factory.
Note that the lower four bits are omitted. On the screen for this application, 0 x 1340 is displayed.

For the upper six bits, all values can be set.

For the lower ten bits, only the following values can be selected:

110, 120, 130, 140, 150, 180, 190, 1A0, 1B0, 1C0, 1D0, 1E0,
220, 230, 240, 250, 260, 280, 290, 2A0, 320, 330, 340, 350

If OK has been selected, the following warning dialog box may pop up.
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Figure 10-2: Warning Dialog Box

This means that the artist board has not correctly reacted to the set I/O address.

Check artist board connection or address setting by the dip switch. If the specified address is used in any
board other than the artist board, this warning dialog box may pop up.

Selecting OK in the warning dialog box causes the set address to be saves forcibly. Selecting Cancel
causes the setting screen to appear.

Typically, in PC/AT or its compatible machine, only the lower ten bits are valid as the I/O address. For the
artist board, however, all 16 bits are valid. For the I/O address set in this application, the lower 10 bits must
be unique against the I/O address to be used in any board other than the artist board.
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